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1 Introduction 

1.1 XTAP 
XTAP (Expandable Transient Analysis Program) is a program for analyzing transient 
phenomena in power systems and other electric circuits at the waveform level. This 
type of analysis has so far been done using programs developed outside Japan, such 
as EMTP. XTAP is thus the first program in this field developed specifically in Japan. It 
provides superior analysis performance compared to conventional programs for 
analyzing power-electronics devices, such as inverters for solar-power generation. 
CRIEPI is also working on developing programs to meet the needs of the domestic 
market. 

 
1.2 Features of XTAP 

Feature 1: High calculation precision, value stability 
XTAP uses highly efficient calculation algorithms for value integration and circuit 
formularization, to achieve a higher calculation precision and value stability than 
conventional programs (see the list of CRIEPI reports in Section 1.5 for information on 
internal program calculation principles and the algorithms used). 
 
Feature 2: Reliable convergence performance (ideal for power-electronics circuit 
analysis) 
Thanks to its proprietary convergent calculation and equation solution algorithms, 
XTAP quickly performs circuit analysis calculations, even in cases of extreme 
nonlinearity. The analysis is almost perpetual (i.e., it does not converge). This algorithm 
is ideal for power-electronics circuits. 
 
Feature 3: Provision of device models for domestic power systems 
Models needed for domestic power-system analysis are provided standard. Various 
control blocks for creating device-control mechanisms can be used. Help information 
is provided in Japanese for all models. 
 
Feature 4: Graphical user interface 
The XTAP interface simplifies circuit creation, enabling the creation of power-system 
models and power-electronics circuits. Analysis results (voltage/current values at user-
specified locations) can also be checked using simple operations. 
 

 
1.3 Operating environment 

XTAP requires the following environment: 
 

Operating system 

Operating 
system 

Microsoft Windows 8, 8.1 (32-bit and 64-bit versions) 
Microsoft Windows 10 (32-bit and 64-bit versions) 

PC  

Memory 32-bit OS: 2.0 GB or more (4.0 GB or more recommended) 
64-bit OS: 4.0 GB or more (8.0 GB or more recommended) 

Hard-disk 
capacity 8 GB or more 

Software required 

Software 
MATLAB Compiler Runtime R2015b 
Microsoft .NET Framework 4.8.1 or newer 
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Screen DPI setting 
Text may not be displayed properly by XTAP if the DPI setting of the screen is changed. 
XTAP will display text correctly for a standard setting of 96 DPI. An increasing in this 
standard setting by the user (e.g., 125% or 150%) is not problematic. The standard 
default setting in Windows is often 96 DPI, but the DPI setting can be changed in the 
‘display properties’ dialog. Consult the help information provided with your operating 
system for instructions. 

 
1.4 Software upgrade caution 

XTAP Version 1.20 and later versions are backward-compatible, supporting circuit-
drawing files (*.xsf files) created by older versions. When the below dialog box appears, 
click ‘Continue’ to start conversion of the file so that it can be used in the current version. 
The file conversion process is done either automatically or manually by the user (for 
example, in the case of user-defined components). Note that once a circuit-drawing file 
has been converted to a more recent version of XTAP, it can no longer be opened using 
the older version. 
 
 

 
  
 
 
For details regarding this file conversion, see “Using a circuit diagram file (xsf file) 
created in an older version” on the XTAP user support site. 
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1.5 XTAP-related CRIEPI reports 
Reports released by CRIEPI relating to the development of XTAP  are listed below. 
The full text of these reports is available free of charge from the CRIEPI download site. 
(The reports are in Japanese with English abstracts.) 

 
Report No. Title 

H06002 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 1) -- 
Fundamental Design -- 

R06017 Development of Inverter Simulation Program (Part 1) - Modeling of MOSFET and Diode - 

H07005 A Transmission Line Model for Electromagnetic Transient Analysis Based on the Frequency 
Region Partitioning Algorithm 

H07004 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 2) - 
Development of a Fundamental Algorithm for Steady-State Calculation - 

R07016 Development of Inverter Simulation Program (Part 2) - Verification of Analysis Accuracy Based on 
Actual Measurement - 

R08022 Development of instantaneous simulation method of an induction motor for transient analysis 

R08027 Design Guideline and Marginal Performance of a SiC Diode Applied Inverter 

R08015 Accelerated Electromagnetic Transient Simulations of Power Electronics Circuits using a Variable 
Time Step Algorithm 

H08002 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 3) - 
Improvements of Convergence Properties for Nonlinear Circuits - 

H09007 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 4): 
Practical Steady-State Initialization 

R09007 
Development of Support System of Setting and Coordination between Protection Relays- Method 
of Checking Coordination including Earth Fault Protections in Distribution Systems with Isolated 
Neutral System- 

R09010 Optimum Circuit Configuration of SiC Device Applied STATCOM for Distribution System 

R09015 Stable Operation Technique for PCS of PV Power Generation at Grid Recovery after Voltage Sag

R10008 Study on introduction of SN transition type FCL into looped distribution system 

R10025 Development of a synchronous machine model considering the magnetic saturation in the stator 
core for electromagnetic transient analysis of power systems 

H10008 
Study on Lightning Protection Design for Distribution, Telecommunication and Consumer Circuits 
(1) -Analytical Study on Lightning Overvoltages on Distribution Lines with Telecommunication 
Cables- 

H11010 Proposal of a Sparkover Model for Short Wave Tail Impulse Voltage Waveforms Applied to 
Distribution Insulators 

H11013 Characteristics of Spark Discharge on Faulty Insulation of 6.6kV Distribution Lines -A Proposal of 
Evaluation Method for Low Frequency Pulsed Electromagnetic Interference- 

H11009 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 5): A 
Fast Algorithm for LU Decomposition of a Large Sparse Matrix 

H11006 Evaluation of Line Constants of Short-Length Underground Cables: Development of a 
Measurement Method and Validation of a Calculation Method 

H12005 Review of Simulation Methods for Electromagnetic Transients in Power Systems and Simulation 
Cases Using XTAP (Part 1): Switching Transient Overvoltage Simulations 

R12005 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 6) - 
Performance Improvements for Nonlinear Circuits - 

R12020 
Preventing Islanding by Distributed Power Generation at Transmission System Fault- Evaluation 
of Characteristic of Detecting Islanding by Power Conditioning Subsystem for Interconnecting 
Many Distributed Power Generations in Area with Rotated Type Distributed Power Generation - 

R12010 Harmonic Instability at Parallel Operation of Line Commutated Converter and Voltage Sourced 
Converter 

H13007 A Dynamic Voltage Simulation Method for Power Distribution Systems by Using Electromagnetic 
Transient Analysis (Part 1): Modeling of Distribution Substation and SVR 
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H13005 Development of an Electromagnetic Transient Analysis Program for Power Systems(Part 7): Fast 
Simulations by Parallelization of Updating Process of Circuit Components 

H13010 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 8): Fast 
Simulations by Single-Phase Phasor-Based Modeling of Remote Power Systems 

R13027 Development of Modular Multilevel Converters Model for High Speed Electromagnetic Transient 
Analysis 

H14013 
Development of a Frequency-Dependent Line Model for Electromagnetic Transient Simulations 
without Model Identification Problems (Part 1): Simulation Performance of an FDTD-Based Line 
Model 

H14014 A Dynamic Voltage Simulation Method for Power Distribution Systems by Using Electromagnetic 
Transient Analysis (Part 2): Modeling of STATCOM 

R14016 
Control and Protection Scheme of HVDC System with Modular Multilevel Converter using Full 
Bridge Cell - Part2: Development of an Operation Method under AC High-Voltage Situation and a 
Method for Fast Start- 

H15004 Development of an Electromagnetic Transient Analysis Program for Power Systems (Part 9): A 
Fast Frequency-Scan Algorithm 

H15014 A Fast Simulation Algorithm for Distribution-System Transients Based on the Theory of Dynamic 
Phasors (Part 1): Proposal of Fundamental Concept 

R15022 Development of Converter Model for High-speed Transient Analysis - Averaged Model with 
Rectifier Circuit - 
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2 Starting XTAP, Main Window 

2.1 Starting XTAP 
The following screen appears after XTAP is launched: 

 

 
 

When the program starts, a menu appears showing the options ‘New’ and ‘Open 
existing file’. To create a new circuit diagram, select ‘New’. To open an existing circuit 
diagram (*.xsf file), select ‘Open existing file’.  
It is also possible to double-click an xsf file displayed in Explorer in order to launch 
XTAP and open that circuit diagram (if an xsf file is double-clicked while XTAP is already 
running, that file will be opened in the running XTAP). Another method of opening an 
xsf file is to drag and drop it onto the XTAP window. 

 

 
  
Selecting ‘New’ opens a blank canvas like the one shown below. 
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Selecting a circuit diagram (*.xsf file) using ‘Open existing file’ or ‘Recently used file’ 
opens the selected circuit diagram. 
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2.2 Terminology 
Terms used within XTAP are defined as follows. 

 
part 
Resistors (linear), sine-wave voltage sources and other component elements of 
electrical circuits or control blocks are referred to as ‘parts’. The term refers to the items 
in the ‘part category’ window on the left side of the screen. 

 
node 
A wire used to connect parts in an electrical circuit is called a ‘node’. Control-system 
wires connecting control blocks are used to denote a connection between the blocks, 
and are different from nodes. 

 
branch 
A ‘branch’ is a synonym of ‘part’. 

 
packaging, macroing 
A set of several parts that compose an electrical circuit or control block can be 
registered collectively as a single part. This operation is known as ‘packaging’. The 
operation of packaging electrical circuits or control blocks containing parts created by 
packaging is called ‘macroing’. Parts created in this manner are sometimes referred to 
as ‘macro parts’. 
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2.3 Main window 
This section describes the main window, which appears when ‘Create circuit diagram’ 
has been selected from the ‘File’ menu and a new circuit diagram is opened. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Menus in the main window 
See Section 2.4 for details. 
 
2. ‘Part category’ window 
This window is used to register parts such as electrical-circuit parts and control-system 
block parts. ‘99 User's Components’ is used to register a user-packaged part. Parts 
other than ‘99 User's Components’ cannot be changed. 
 
3. Zoom setting 
This setting is used to change the screen-display size by selecting the desired 
magnification. The screen display size can also be changed by holding down the ‘Ctrl’ 
key on the keyboard while turning the mouse wheel. At this time, it operates so that the 
mouse position at the moment when Ctrl key is pressed can be located at the center of the screen. 
 
4. XPLT button 
This button starts XPLT (the graphing program). XPLT is described in Chapter 9. 
 
5. XTLC button 
This button starts XTLC (the line-constants calculation program). XTLC is described in 
Appendix 1. 
 
6. XFIT button 
This button opens XFIT (the system-identification program for XTAP). XFIT is described 
in Appendix 2. 
 
7. Circuit-diagram canvas 
This space is used to place the parts and create the circuit diagram. 

  

1 
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3 

8 
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8. Gray circuit diagram canvas background color 
The canvas background color is gray when editing a circuit diagram, or when editing a 
circuit in a packaged part (editing a macro part). Part editing is described in Chapter 
10. 
 
9. Circuit diagram canvas coordinate display 
When the cursor is located over the canvas, its coordinates in the canvas coordinate 
system are displayed at the bottom-right corner of the window. 

 
 
 

2.4 Menus in the main window 
This section describes the top-level XTAP menus and the corresponding menu items. 

 
(1) File (F) menu 
 

 
 
Create circuit diagram 
• opens a new (blank) circuit diagram. The same operation can be performed by 
clicking the toolbar button indicated below. 
 
 
Open circuit diagram 
• opens a previously created circuit diagram (*.xsf file). The same operation can be 
performed by clicking the toolbar button indicated below. 
 
 
Create component 
• allows the definition of a new part. Defined parts are registered in the ‘99 User's 
Components’ category. 
 
 
Open component 
• opens a part already registered as a user-defined part. 
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Rename component 
• allows a change in the name of a part that was previously registered as a user-defined 
part. 
 
 
Create category 
• creates a new category in the ‘99 User's Components’ category. 
 
Save 
• saves the circuit diagram, replacing any previous version with the current version. 
The same operation can be performed by clicking the toolbar button indicated below. 
This button is active only when the circuit diagram has been changed after being 
opened. The button is inactive (with a gray appearance) otherwise. 
 
 
Save as 
• saves the circuit diagram under a new name. 
 
 
Export 
• outputs and saves the part information registered in the ‘Part category’ window in 
the ‘XTAP Components Backup File’ format. It is also possible to output the image of 
a circuit canvas as an image file. Selecting this menu item displays the window 
shown below. This window can be used to enter a file name and select the desired 
image-file type in which to save the circuit canvas. The EMF, bitmap, GIF, JPEG, 
PNG, or TIFF file format can be selected. 
 

 
 
 
Import 
• reads the part information output by the export function into XTAP, and registers it in 
the ‘part category’ window. It is possible to either import all part information as a batch 
(automatic part importing) or select parts one at a time (individual part importing). 
 
 
Page settings 
• defines settings for printing, such as the page size and printer settings. 
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Print 
• prints the circuit diagram. This operation can also be performed by clicking the toolbar 
button indicated below. 
 
 
Print preview 
• displays a preview of how the printed circuit diagram will appear. This operation can 
also be performed by clicking the toolbar button indicated below. 
 
 
Exit application 
• terminates the XTAP application. 
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(2) Edit (E) menu 
 

 
 
 

Undo 
• Undo one of the changes made to the circuit. 
 
 
Redo 
• Restores one of the changes made to the circuit canceled by “Undo”. 
 
 
Cut 
• Cuts the selected component or node from the circuit diagram. 
 
 
Copy 
• Copies the selected component or node. 
 
Paste 
• Pastes the “cut” or “copied” component or node into the circuit diagram. The names of the 
pasted component and node are as follows. 
 

 Component: Will be renamed to a unique new name. 
 Node 

 Default name: Will be renamed to a unique new name. 
 User-set name: Will be pasted with the original name (considered the same node). 

When pasting, a message indicating this will appear. 
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Keep Name and Paste 
• Paste the “cut” or “copied” components or node to the circuit diagram while keeping the name. 
It operates as follows, depending on components and nodes that exist in the circuit of the paste 
destination. 
 

 If a component with the same name exists: 
XTAP does not allow a component with the same name to be placed on the same 
hierarchy. Therefore, the following message will appear, asking you to select either 
renaming and pasting or canceling the paste operation. If you select “Yes to all”, XTAP 
will automatically select “Yes” for all subsequent cases where the same message 
appears. 

 
 If a node with the same name exists: 

In XTAP, nodes with the same name existing on the same hierarchy are considered to 
be the same node (even if they are far apart on the circuit diagram campus). Therefore, 
the following message will appear, asking you to select either pasting while keeping 
the name or canceling the paste operation. If you select “Yes to all”, XTAP will 
automatically select “Yes” for all subsequent cases where the same message appears. 

 
 
Delete 
• Delete the selected component or node. 
 
 
Select All 
• Copies the selected component or node. 
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(3) Circuit (C) menu 
 

 
 
 

Select 
• selects a component (e.g., a part or wire) located on the circuit diagram canvas. This 
operation can also be performed by clicking the toolbar button indicated below. 
 
Electrical-circuit wire 
• switches to the mode used to create an electrical circuit wire. This operation can also 
be performed by clicking the toolbar button indicated below. 
 
Three-phase bus 
• switches to the mode used to create a three-phase bus. This operation can also be 
performed by clicking the toolbar button indicated below. See Section 5.6 for details of 
how to create a three-phase bus. 
 
Electrical-circuit N-line concentrator 
• switches to the mode used to create a line concentrator that packages multiple 
electrical circuit wires. This operation can also be performed by clicking the toolbar 
button indicated below. See Section 5.7 for details of how to create a line concentrator. 
 
Control-system wire 
• switches to the mode used to create a control-system wire. This operation can also 
be performed by clicking the toolbar button indicated below. See Section 5.3 for details 
of how to create control-system wires. 
 
Multiple-signal control system wiring  
• switches to the mode used to create wiring for a multiple-signal control system. This 
mode can also be selected from the ‘Multiple-signal control system wiring’ icon button. 
See Section 5.5 for details. 
 
Control-system N-line concentrator 
• switches to the mode used to create a line concentrator that packages multiple control 
system wires. This operation can also be performed by clicking the toolbar button 
indicated below. See Section 5.7 for details of how to create a line concentrator. 
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Text string 
• enters a comment in the circuit diagram. This operation can also be performed by 
clicking the toolbar button indicated below. 
 
Search 
• searches for a component placed in the circuit diagram. This operation can also be 
performed by clicking the toolbar button indicated below. See Section 6.7 for a 
description of the search function. 
 
Package 
• packages the parts selected in the circuit diagram and creates a new composite part 
(a macro part). This operation can also be performed by clicking the toolbar button 
indicated below. This menu option is only active if a part is selected (otherwise the icon 
is grayed out). See Section 10.1 for details of how to package parts (create macro 
parts). 
 
Edit all branch properties 
• allows editing of the recording properties and display properties of all the branches 
(circuit parts and control parts) in the currently active layer simultaneously. This 
operation can also be performed by clicking the toolbar button indicated below. 
 
Selecting this menu item displays the following window. Use this window to turn the 
recording/display properties of parts ON or OFF. Clicking on one of the cells in the 
column headings at the top left of the table sorts the list in the corresponding order. 
Each click of these cells toggles the sort order between ascending and descending. 
Changes made in this window are applied to the corresponding parts. To switch 
between circuit parts and control parts, use the tabs at the top left of the window. 
 

 
 
Edit all node properties 
• lets you edit the recording properties and display properties of all the nodes 
(electrical-circuit and control-circuit wires) in the currently active layer simultaneously. 
This operation can also be performed by clicking the toolbar button indicated below. 
The operation performed by selecting this menu item is the same as for the ‘Edit all 
branch properties’ menu item. 
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Display all branch names 
• displays the names of all the branches in the currently active layer. This operation 
can also be performed by clicking the toolbar button circled below. 
Selecting this menu item, or clicking the corresponding toolbar button, displays all the 
branch names. A further selection of the menu item or click of the button disables this 
function, restoring the branch-name display settings specified in the properties for each 
part. Note that this function has no effect on branches that are already set to display 
the branch name. Also, note that selecting this menu item has no effect on the part 
properties, unlike when the display properties are turned ON or OFF by selecting the 
‘Edit all branch properties’ menu item. 
 
 

     
 
 
 
 
 
Display all node names 
• displays the names of all the nodes in the currently active layer. This operation can 
also be performed by clicking the toolbar button indicated below. 
Selecting this menu item, or clicking the corresponding toolbar button, displays all the 
node names. A further selection of the menu item or click of the button disables this 
function, restoring the node name display settings specified in the properties for each 
node. Note that this function has no effect on nodes that are already set to display the 
node name. Also note that selecting this menu item has no effect on the node properties, 
unlike when the display properties are turned ON or OFF by selecting the ‘Edit all node 
properties’ menu item. 

 
  

Display enabled Display disabled
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(4) Analysis (A) menu 
 

 
 
 

Analysis settings 
• opens the settings screen used to set the analysis conditions. This operation can also 
be performed by clicking the toolbar button indicated below. Analysis processes are 
described in Chapter 6. 
 
Run analysis 
• performs an analysis using the previously set analysis conditions. This operation can 
also be performed by clicking the toolbar button indicated below. An analysis cannot 
be executed when the circuit has been changed. In this case, the menu item and button 
for this operation are inactive (grayed-out and inoperable). You must first save the 
circuit before performing an analysis on it. 
 
Save and run alysis 
• saves changes to the current circuit and then runs the analysis.You can also select 
from the "Save and run analysis" icon button.This function can also be operated by 
pressing the F5 key. 
 
Consecutive-analysis settings 
• opens the ‘analysis settings’ screen, used to set multiple combinations of circuit 
parameters such as circuit resistances, inductances, and breaker ON times (multiple 
analysis cases), and to execute those multiple analysis cases consecutively and 
automatically. This menu item is also used to define the settings for statistical switching-
surge calculations. The operation of this menu item can also be executed by clicking 
the toolbar button indicated below. See Chapter 7 for details. 
 
Run consecutive analysis 
• performs a consecutive analysis using the previously set consecutive-analysis 
conditions. This operation can also be performed by clicking the toolbar button 
indicated below. Note that a consecutive analysis cannot be executed when the 
consecutive-analysis settings have not been entered or the circuit has been changed. 
In these cases, the menu item and button for this operation are inactive (grayed-out 
and inoperable). The circuit must be saved before performing a consecutive analysis. 
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(5) View (V) menu 
 

 
 
 
Toolbar 
• enables/disables the display of the toolbar in the XTAP main window. 
 
Status bar 
• enables/disables the display of the status bar in the XTAP main window. 
 
Grid display 
• enables/disables the grid display in the circuit-diagram canvas. This operation can 
also be performed by clicking the toolbar button indicated below. 
 
Print-area display 
• enables/disables the print-area display on the circuit-diagram canvas. Enabling the 
print-area display shows the set print-sheet positions (the print area for each sheet) in 
the circuit canvas when two or more horizontal or vertical sheets have been set in the 
canvas-size settings. The operation of this menu item can also be performed by clicking 
the toolbar button indicated below. 
 
The screen shot below shows an example of the display produced when the print-area 
display has been enabled, and the ‘3 horizontal/2 vertical’ settings have been selected 
in the canvas-size settings (with A4 size paper). The dotted green lines indicate the 
print area of each sheet. Printing with these settings will result in six A4 sheets being 
printed. 
 

 
  



 

- 19 - 

(6) Tools (T) menu 
 

 
 
Circuit-diagram canvas size 
• allows a change to the size of the circuit-diagram canvas. This size is specified in 
terms of the paper size supported by the selected printer driver, and the number of 
sheets in the horizontal and vertical directions (with a maximum of nine sheets in the 
horizontal direction and six sheets in the vertical direction). 
 

 
 
 
Component canvas size 
• changes the size of a part icon’s canvas. It is possible to specify any width and height 
for the size of the component canvas. See Section 10.3 for details. 
 
 
XPLT (graphing program) 
• starts XPLT (the graphing program). XPLT is described in Chapter 9. 
 
 
XTLC (line-constants calculation program) 
• starts XTLC (the line-constants calculation program). XTLC is described in 
Appendix 1. 
 
 
XFIT (system-identification program) 
• starts XFIT (the system-identification program for XTAP). XFIT is described in 
Appendix 2. 
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(7) Window (W) menu 
 

 
 
Opens a new window 
• Opens the same xsf file that is currently open in a new window. 
 
Cascade 
• Switches the display method for the circuit diagram files to a multi-window view to cascade 
all circuit diagrams that are currently open. 
 
Vertical 
• Switches the display method for the circuit diagram files to a multi-window view to display 
all circuit diagrams that are currently open vertically at equal intervals. 
 
Horizontal 
• Switches the display method for the circuit diagram files to a multi-window view to display 
all circuit diagrams that are currently open horizontally at equal intervals. 
 
Close All 
• Closes all circuit diagrams that are currently open. 
 
Arrange Icons 
• Arranges the small windows at the bottom of the screen when the window display is 
minimized. 
 
“Name of the open circuit diagram file” *May be none or multiple. 
The window name of the currently-open circuit diagram file will be displayed on the list. 
When editing a hierarchized component, it will be recognized as a single window. If one of 
the windows is selected here, the selected window will be displayed in the foreground. 
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(8) Help (H) menu 
 

 
 
User's Manual 
• Opens the same xsf file that is currently open in a new window. 
 
Cascade 
• Opens a PDF file of the XTAP user’s manual (this document). (The file will be opened by the 
application associated with the PDF file.) 
 
Version Information 
• Displays the version information of the currently activated XTAP. 
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3 Workflow From Circuit-Diagram Creation Through Analysis 

The XTAP workflow needed to create a circuit, execute its analysis, and graph the 
results is illustrated below. See the sections indicated in the flowchart for descriptions 
of the corresponding procedures. 
 
⚪ Using XTAP (circuit creation/calculation program) 
 
Creating circuit 

 
 
 
 
 
 
 
 
 

Selecting analysis type 

 
 
 
 
 
 
                 Analysis execution 

 
 
 
 
 
 
 
 
 

Part property settings  
(parameter input/output specifications, etc.)

Part connection 
(circuit creation) 

Part macroing  
(creation of macro parts) 

Transient 
analysis 

Steady-state initialization  
→ Transient analysis 

Flow calculation → Steady-state initialization 
→ Transient analysis 

Frequency characteristic 
calculation 

Analysis condition settings 
(analysis time, output file, etc.)

Analysis execution 

Analysis 
result file 

(*.xpf) 

See Section 4.2 

See Section 4.4

See Chapter 5

See Chapter 10 

See Section 6.2 

See Section 6.3 

See Section 6.4 

See Section 6.5 

Analysis result file (*.xpf) 
creation 

Part placement  
(circuit parts, control block parts)
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⚪ Using XPLT (graphing program) 
 
 
    Graphing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Normal graphing 
● Time-series graphs 
● XY plot 
● Frequency characteristic 

graphs 

Modified graphs 
● Integrals 
● Fourier transforms 
● Fourier series 

expansions 
● Constants (a*f(t)+b) 

See Chapter 9 

Analysis 
result file 

(*.xpf) 

Load analysis result file (*.xpf) 
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4 Creating Circuit Diagrams 

4.1 Part types 
The parts in XTAP are of the following types: 
 
1. Electrical-circuit parts 
These parts constitute electrical circuits and include resistors, power supplies, and 
switches. Electrical circuit parts can be connected to each other either directly (by 
red square terminals), or to control parts using components such as voltage/current 
probes (control outputs), and controller control voltage/current sources. There are 
both single-phase and three-phase parts, both of which have different terminals. A 
voltage, current, or instantaneous power can be viewed as forming the part output. 
 
2. Control-block parts 
These parts constitute control blocks. In control blocks, signal inputs are denoted as 
yellow terminals, and outputs as blue terminals. A blue terminal output is connected 
to a yellow terminal. There are both single-signal and multiple-signal wirings, both of 
which have different terminals. Connections to electrical circuit parts are made using 
components such as voltage/current probes (control outputs) and controller control 
voltage/current sources. Output signals can be viewed as forming the part output. 
 
3. Macro parts 
These composite parts are created by packaging circuit parts or control-block parts 
together. The rules for making connections to macro parts are the same as for the 
individual parts. A macro part can be created within another macro part. Macro parts 
can be referenced and edited in circuit diagrams. 
 
 

4.2 Part placement (electrical-circuit part/control-block 
part) 

XTAP allows parts to be placed easily in a circuit diagram by ‘drag and drop’ using the 
mouse. 
 
1. From the ‘File’ menu, select ‘New (N)’ → ‘Create circuit diagram (X)’. In the ‘part 
category’ window on the left, select the category containing the part you want to place 
in the circuit diagram. In the example below, a (linear) resistor is being added, and 
therefore ‘01 RLCs’ is selected. 

 
 

 
 
 



 

- 25 - 

2. The parts registered in the ‘01 RLCs’ category are displayed. Selecting one of 
these parts displays its icon in the upper window. 
 

 
 
 
3. Select the name of the part to place, and drag the selection onto the circuit 
diagram. (‘00 Resistor (linear)’ has been selected in this example.) 
 

 
 
 
4. A (linear) resistor is placed on the circuit diagram. 

 

  

Drag 
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4.3 Part operations 
 
(1) Selecting and moving parts 
 
Clicking on a part selects it and displays green markers on it. The part can then be 
moved freely by standard drag-and-drop. 

 
 
Clicking on different areas of a part selects different items. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Clicking on 
1 selects the caption label (part name). A double click allows the part to be 

renamed directly. It is also possible to rotate the orientation by 90 degrees from 
‘Figure’ menu that appears by right-clicking the caption label (new function 
added in Ver. 2.10). Text strings used as part names may contain upper- or 
lowercase letters, numbers, and the underscore (_) character, but the first 
character cannot be a number. Japanese characters or other Asian-width 
characters may not be used in part names. 

 
 
 
 
 
 
 
2 selects the part itself. A double click opens the ‘properties’ screen. See Section 

4.4 for information on the ‘part properties’ screen. Right-clicking displays the 
‘part’ menu, described in Item (2) on the next page. 

3 selects the terminals (displayed in red), serving as the connection points to other 
parts. 

4 selects the ‘parameter’ label. Its value can be changed on the ‘properties’ screen. 
Some parts do not have parameter labels. 

5 selects the ‘initial value’ label, which can be changed on the ‘properties’ screen. 
Some parts do not have an initial value label. 

6 This line is displayed when the XPLT output has been specified. See Section 
4.4 for more information. 

1 

5 

2 

4 

6 

3 

Supported text string: 

‘a’ to ‘z’, ‘A’ to ‘Z’, ‘_’ or ‘0’ to ‘9’ 

‘a’ to ‘z’, ‘A’ to ‘Z’, or ‘_’
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(2) Part menu 
The ‘part’ menu is displayed when right-clicking on a part. 

 

 
Cut 
• cuts the part. 
 
Copy 
• copies the part. 
 
Paste 
• pastes the most recently cut or copied part. (See the note on the next page.) 
 
Paste with same name 
• pastes the most recently cut or copied part together with its name. (See the note on 
the next page.) 
 
Delete 
• deletes the part. 
 
Disconnect 
• It is possible to cut a circuit line by right clicking the corresponding node and selecting 
"Disconnect". 
 
Component - Show - Show Names 
• Show the component name in the diagram. 
It is possible to do the same action by selecting the component and pressing the key 
"E". 
 
Component – Show – Hide names 
• Hide the component name in the diagram. 
It is possible to do the same action by selecting the component and pressing the key 
"D". 
 
Component – Bring to front 
• moves the part to the foreground plane. 
 
Component – Send to back 
• moves the part to the furthest background plane. 
 
Component – Rotate Right 90° 
• rotates the part 90 degrees clockwise. This operation can also be performed by 
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pressing the ‘R’ key on the keyboard when the part is selected. 
 
Component – Rotate Left 90° 
• rotates the part 90 degrees counterclockwise. 
 
Component – Flip vertically 
• flips the part vertically. 
 
Component – Flip horizontally 
• flips the part horizontally. This operation can also be performed by pressing the ‘R’ 
key on the keyboard when the part is selected. 
 
Properties 
• displays the ‘part properties’ screen. 
 
● Difference between ‘Paste’ and ‘Paste with same name’ in part menu 
 
Every part name in XTAP must be unique (no two part names can be the same). 
Therefore, when a part is copied and pasted, the name of the pasted part is the default 
part name appended with a number. However, when ‘Paste with same name’ is 
selected, the pasted part keeps the name of the original part provided that no part with 
that name already exists on the target canvas. 
 
 

 
 
 
 

   
  

Copied part

Paste Paste with same name
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If a part with the same name already exists on the destination canvas, the message 
shown below on the left appears, asking for confirmation to execute the paste operation. 
(If the operation is executed, the part name becomes appended with an underscore 
character.) Unlike parts, nodes with the same name may coexist on the same canvas. 
However, in this case, program calculations will handle those nodes as if they were the 
same node, even if they are at different locations on the circuit diagram (see Section 
5.1). When executing the ‘Paste with same name’ command and if a node of the same 
name already exists on the canvas, the message below on the right then appears. 
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(3) Macro part menu 
In addition to the part menu items previously described, the following additional part 
menu items can also be selected for macro parts. See Chapter 10 for details of how to 
create and edit macro parts. Macro parts are created by selecting portions of the circuit 
diagram and packaging them as a new composite part. 
 

 
Edit icon 
• displays a screen for editing the part’s icon. See Section 10.3 for details of how to 
edit icons. 
 
Component properties 
• allows the specification of part information. 
 
Edit packaged diagram 
• displays the part’s circuit diagram. See Section 10.2 for details of how to change 
macro parts, and Section 10.4 for how to set connection terminals. 
 
 
(4) Component manipulation by using the keyboard/mouse 
Besides moving components placed in the diagram by dragging with the mouse, it 
is possible to move components by selecting it and pressing the keyboard direction 
keys. 
Moreover, by pressing specific keys and selecting components, it is possible to 
selecting several components at once, to copy them or to move them 
horizontally/vertically. 
 
(Ctrl key) + (Left click) 
• It is possible to select several components at once. It shows the same behavior of 
(Shift key) + (Left click) 
 
(Shift key) + (Left click) 
• It is possible to select several components at once. It shows the same behavior of 
(Ctrl key) + (Left click). 
 
(Ctrl key) + (drag and drop) 
• Copy the selected component. It can be used together with the shift key for 
moving the component horizontally/vertically. 
(Shift key) + (drag and drop) 
• Move the selected component horizontally or vertically only. It can be used together 
with the ctrl key for copying the component.  
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4.4 Part properties screen 
A double click on a part displays the properties screen for that part. 
 
(1) Parameters 
Parameters are the properties that define the calculation conditions. Information about 
a part’s parameters is provided in the help tab of its respective ‘properties’ screen. 
Some control blocks have no specifiable parameters. 
 

 
 
 
(2) Initial value 
An initial value can be set for some parts. The way to set an initial value is described 
in the help tab of the ‘properties’ screen. 
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(3) Recording 
• used to specify the items from which to generate outputs to graph. The checked items 
will be displayed by XPLT (the graphing program). XPLT is described further in Chapter 
9. Even when executing an analysis, only the checked items will be output as 
waveforms. The appropriate checkboxes must therefore be checked to obtain the part 
voltage, current, or power observations, as required. The following three types of 
values can be output for circuit parts: 
 

Branch voltage 
Branch current 
Branch power 

 

 
 
 
In the case of control blocks, the output signal can be an output. 
 

 
 
In macro parts, their internal parts, and the existence of various signals of nodes (node 
voltage, branch voltage, branch current, branch power, and control signal) can be 
specified. When a macro part is turned off, even if any part’s signal recording is on 
inside that macro part, output is still disabled. 
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(4) Display 
• enables or disables the display of various display labels for a part on the circuit-
diagram canvas. 
 

 
 

Name 
The part name can be entered in the text box. Checking the checkbox displays the 
part’s caption label on the circuit-diagram canvas. In some power transmission line 
components, the line length can be displayed. 
 
Parameter 
Checking this checkbox displays the part’s parameter label on the circuit diagram 
canvas. The parameter displayed is determined by the part type. 
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Recording 
Checking this checkbox displays the items selected in the Recording tab as the 
part’s output label on the circuit-diagram canvas. In the example below, the branch 
voltage and branch current have been selected in the Recording tab. 

 
 

Initial value 
Checking this checkbox displays the part’s initial-value label on the circuit 
diagram canvas. The initial value displayed is determined by the part type. 

 
 

(5) Help 
• displays help information for a specific part. 
 

 
 
 

(6) Acquiring information from power-flow calculations (macro parts 
only) 
User-created macro parts have a tab for power-flow calculation information. The 
information in this tab is described in Chapter 8. 
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5 Part Connections 

5.1 Creating electrical-circuit wires 
This section describes how to create the electrical-circuit wires (nodes) that connect 
different parts. As an example, a (linear) resistor and a (linear) inductor are first placed 
on the circuit diagram canvas as described in Section 4.2. 

 
 
1. Click the right terminal of the resistor. The mouse cursor becomes a plus sign 

(+), indicating the program has switched from part-selection mode to the mode 
used for automatically creating electrical-circuit wires. To switch to this mode 
manually, select ‘Electrical circuit wire’ from the ‘Circuit’ menu. 

 
 
2. Move the mouse to draw a line. In this example, the mouse is moved toward the 

left terminal of the inductor. Lines cannot be drawn diagonally. 
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3. Change the direction of the line by clicking at the desired point of change. In the 
example below, the line has been drawn horizontally, vertically, and then 
horizontally again. 

 

 
4. Move the mouse to the left terminal of the inductor, then double-click to make 

the connection. Once the terminals are connected, their red squares disappear. 
If the terminal has a horizontal orientation, the line also needs to be connected 
horizontally. Horizontally oriented terminals cannot be connected from a vertical 
direction. 

 

    
 
 
5. When an electrical circuit wire (node) is created, the program automatically 

assigns it a unique name. Node names are not displayed under default display 
settings. To check or change a node name, double-click the wire to open the 
node’s ‘properties’ screen. See Section 5.2 for information on node properties. 

 

 
 

Not connected 
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6. The node name can be changed in the node’s ‘properties’ screen (see Section 
5.2). If the assigned node name already exists in the same layer, the nodes of 
that name will be considered to be the same node, and will be handled as if they 
were connected, even if they are not connected in the canvas wiring. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Whether or not a node name has been changed affects the node-name setting when 
the node is copied/pasted. 
⚪ When an unrenamed node is copied/pasted 
The name of the pasted node is changed to a different unique node name, and the 
node is handled as a different node. 
⚪ When a renamed node is copied/pasted 
The pasted node preserves the changed node name, resulting in the existence of 
multiple nodes with the same name. In this case, the following message appears. 
 

 
 
As when changing a node name, care is needed since nodes with the same name are 
treated as the same node. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Name is changed when 
pasted → Different nodes 

Node name was changed,
so same name is 
preserved when pasted → 
Same node 

Node name not 
changed 

Node name 
changed 

Same node name

Equivalent to 
connection on right 
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5.2 Electrical-circuit wire (node) properties 
Double-clicking a node displays its ‘properties’ screen. 
 
 
(1) Display 
This tab enables or disables the display of the electrical circuit wire name on the circuit-
diagram canvas. Checking the checkbox displays the node name on the circuit-
diagram canvas. The text box can be used to change the node name. 
 

 
 
 
(2) Recording 
Checking the checkbox in this tab sets XPLT (the graphing program) to display the 
node voltage (voltage to ground). XPLT is described in Chapter 9. 
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5.3 Creating control-system wires 
Unlike electrical-circuit parts, control system parts have input terminals (colored 
orange) and output terminals (blue). Input terminals must always be connected to 
output terminals, and output terminals to input terminals. Control system parts are 
connected in the same way as electrical-circuit parts. As an example, place a ‘constant’ 
part (40 Control function block) and an ‘initial value’ part (42 Control function block) 
onto the canvas. 

 
1. Click the (blue) output terminal of the constant part (FIX1). The mouse cursor 

then changes to a plus sign (+), indicating the program has switched from ‘part 
selection’ mode to the mode for automatically creating control system wires. (To 
switch to this mode manually, select ‘Control system wire’ from the ‘Circuit’ 
menu.) Connect the control system wire to the (orange) input terminal of the 
initial value part (INIT1) in the same way as when making a node connection. 

 
2. Once the wire has been connected correctly, the blue and orange boxes 

indicating the terminals disappear. An arrow indicating the wiring direction is 
displayed at the input terminal. 
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5.4 Control system wire properties 
Double-clicking on a wire displays its ‘properties’ screen. 

 
Display 
This screen is used to enable or disable the display of the control-system wire name 
on the circuit-diagram canvas. Checking the checkbox in this tab displays the name of 
the wire name on the canvas. Since the control-system wiring represents the control-
block connections, the wires have no associated values, and therefore do not have a 
‘Recording’ tab. 
 

 
 
 

5.5 Creating multiple-signal control system wirings 
This section describes multiple-signal control system wirings (vectors) that group 
together multiple control signals. Basic operations are same as for a single-signal 
control system wiring. 
 
First, create a vector signal including three elements from three single signals 
(conventional control signals). Place any three single signals on each (in this case, 
‘constant’ [42 Control function block] and ‘vector creation’ [46 Special function function 
block]). 
 

 
 
1. Next, double-click the part ‘vector creation (MTINP1)’ to open the properties 

screen, and change the number of elements to 3. 
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2. Next, click the constant (FIX1) output terminal (blue). The mouse cursor will turn 

into a ‘+’, and the mode will automatically change from the part selection mode 
to the control system wiring creation mode. After this, wire the control system 
wiring to the ‘vector creation (MTINP1)’ input terminal (orange) in the same way 
as for the node connection. Once the wiring is properly done, the □□ of the 
connected terminal will disappear, and an arrow indicating the direction of wiring 
will appear on the input-side terminal. 

 

 
 
3. The wiring is completed once all of the single signals are connected. The output 

of the part ‘vector creation (MTIPN1)’ is the vector signal. As shown in the 
diagram below, the signal lines have different thicknesses. 
 
The vector signal line can only be connected to the vector signal line’s terminal 
(the thick □□). 
 
Also note that parts that can handle the vector signal have “vector” at the front of 
their part names. 
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4. To only isolate one element from the vector signal line, use ‘Vector element value 
output’ (46 Special function function block). Here we will isolate the second 
signal from the previously created vector signals. 
 
First, place ‘vector element value output’ on the canvas. 

 

 
 
5. Next, double-click the part ‘Vector element value output (MTOUT1)’ to open its 

property screen, and input 2 (half-width digit) as the output element number. 
 

 
 
6. Finally, connect ‘Vector creation (MTIN1)’ and ‘Vector element value output 

(MTOUT1)’. The output of MTOUT1 becomes a single signal. 
 

 
 

  



 

- 43 - 

5.6 Creating three-phase buses 
A three-phase bus enables three phases of electrical circuit wiring to be connected to 
a single wire (bus). 

 

 
 
1. Select ‘Three-phase bus’ from the ‘Circuit’ menu in the main window. The mouse 

cursor changes to a plus sign (+), indicating that the program has entered the 
mode for creating a three-phase bus. 

 
2. Click the circuit-diagram canvas and move the mouse straight downward. A line 

is drawn, thicker than a connection line. 

 
3. To change the drawing direction from vertical to horizontal, click at the desired 

location. The bus changes direction at the click location. 
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4. The example below describes how to connect a three-phase power source and 
power-transmission line with two parallel lines to a single bus. For simplicity, the 
transmission line is implemented as resistors. 

 

 
 
 
02 Sine wave voltage source 
From the category ‘02 Sine wave voltage sources – 00 Independent voltage 
source/current sources’ in the ‘part category’ box, select and place a ‘02 Sine wave 
voltage source’. Create three of these parts on the left side of the bus. From the part 
menu, select ‘Figure – Rotate 90 degrees right’ to rotate the parts. 
 
00 Resistor (linear) 
From the category ‘01 RLCs’ in the ‘part category’ box, select and place ‘00 Resistor 
(linear)’. Create six of these parts on the right side of the bus. 
 
5. Connect the ‘02 Sine wave voltage source’ part and the bus. Perform the same 

operation for creating a wire to connect the right terminal of the ‘02 Sine wave 
voltage source’ part to the bus. 

 
 

 
 
 
6. Move the mouse cursor to the bus and double-click. 
 
7. If the connection is successful, a window for selecting the wire name appears. 
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[Wire name:] 
The letters ‘a’, ‘b’ and ‘c’ indicate phases a, b and c. Select which phase to connect 
the wire to. 
 
[Connection wire name:] 
This field displays the connection wire name. ‘Wire name’ shows the phase, while 
‘Connection wire name’ shows the name of the wire actually connected. 
 
8. To connect to phase a, select ‘a’ as the wire name and click ‘OK’. The program 

automatically assigns the connection wire name. This name is displayed to 
identify the wire. To erase the name, uncheck the [Display] checkbox in the node 
properties. 

 
9. Repeat Steps 6 and 7 to connect the second ‘02 Sine wave voltage source’ part 

to the bus. 
 
10. If the connection is successful, the window for selecting the wire name appears. 

To connect to phase b, select ‘b’ as the wire name. If phase a is selected, it will 
be shown to be already connected to a different wire. 

 
11. Repeat the above operation to connect the ‘00 Resistor (linear)’ parts to the bus. 

When R1 is connected to the three-phase bus, the window for selecting the wire 
name appears. In the example below, ‘a’ is selected to connect it to phase a. 

 
12. Repeat the above steps for the other resistors, connecting R4 to phase a, R2 

and R5 to phase b, and R3 and R6 to phase c. 
 
The two circuit diagrams below depict equivalent circuits. 
 

                
 

Equivalent
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13. To change the length of a previously created three-phase bus, switch to the 
‘three-phase bus’ mode, and click on one end of the bus. Drag the mouse in the 
desired direction to extend the bus to the desired length. One bend in the bus is 
deleted at each right-click of the mouse. 

 

                 
 
14. Buses are also assigned unique names. To display the name of a bus, double-

click on the bus to display its properties. Check the checkbox in the [Display] tab 
to display its name. When performing a power-flow calculation, the bus name is 
the name of the connection node used for the parts that appear in the calculation. 

 

       
 

 
  

Click end 
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5.7 Creating line concentrators 
Line concentrators allow the drawing of multiple connection lines as a single line. There 
are two types of line concentrators: electrical circuits are displayed as thick black lines, 
and control systems are displayed as thick blue lines (in versions up to Ver. 2.01, 
electrical circuit N-line concentrators were thick blue lines, and control circuit N-line 
concentrators were thick green lines). Also, the number of signals included in a wiring 
is shown at that wiring’s edge (‘N = *’). The required line-concentrator type depends on 
the part type, but the connection method and operations are the same. Also note that 
when calculating power flow, it is necessary to use a “three-phase bus,” not an 
“electrical circuit N-line concentrator.” 
 

          
 
 

 
 
 
 
1. Select ‘Electrical circuit N-line concentrator’ from the ‘Circuit’ menu in the main 

window. The mouse cursor changes to a plus sign (+), indicating the program 
has switched to the ‘electrical circuit N-line concentrator’ mode. 

2. Click on the circuit-diagram canvas, and move the mouse straight downward. A 
line is drawn, thicker than an electric circuit wire. 

 

 
 
3. Click the mouse to change the drawing direction from vertical to horizontal. Then, 

move the mouse cursor to the right. 

 
  

Electrical circuit  
N-line concentrator 

Control circuit  
N-line concentrator 

Example of electrical circuit N-line concentrator use 
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4. Click the mouse again to change the drawing direction back to vertical. Move 
the mouse upwards. Double-click to complete the line concentrator. After the 
line is placed, ‘N = 2’ will appear on the edge of the line as the number of line 
concentrators (two by default). 

 

 
 
5. Place parts as shown below. 

 
 
02 Sine wave voltage source 
From the category ‘02 Voltage source/current sources – 02 Independent voltage 
source/current sources’ in the ‘part category’ box, select and place an ‘02 Sine wave 
voltage source’. Create and place four of these parts on the left of the line 
concentrator. From the part menu, select ‘Figure – Rotate 90 degrees right’ to rotate 
the parts. 
 
00 Resistor (linear) 
From the category ‘01 RLCs’ in the ‘part category’ box, select and place ‘00 Resistor 
(linear)’. Create and place four of these parts on the right of the line concentrator. 
 
6. Connect the ‘02 Sine wave voltage source’ part and the line concentrator. 

Perform the same operation used when creating a wire, to make a connection 
from the right terminal of the ‘02 Sine wave voltage source’ part to the line 
concentrator. 

 
7. Move the mouse cursor to the line concentrator and double-click. 
 
8. If the connection is successful, a window for selecting the wire name appears. 
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Wire name 
Select the names of the wires controlled by the line concentrator. A wire name is 
added each time the ‘Add wire’ button is clicked. Since the purpose is to make an N-
phase connection, the wire names will be 1, 2, 3, ...N. To delete unneeded wire 
names, right-click on the line concentrator and select ‘Reassign numbers’. 
 
 
Connection wire name 
This command displays the name of the connection wire. ‘Wire name’ shows the 
phases, while ‘Connection wire name’ shows the name of the wire actually connected. 
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9. To connect to the first node, select ‘1’ as the wire name, and click ‘OK’. The 
connection-wire name is displayed, identifying the wire. To erase the name, 
uncheck the [Display] checkbox in the properties. 

 

 
 
10. Repeat Steps 6 and 7 to connect the second ‘02 Sine wave voltage source’ part 

to the line concentrator. 
 
11. If the connection is successful, a window for selecting the wire name appears. 

To connect to wire 2, select ‘2’ as the wire name. 
 
12. Repeat Step 10 to connect the remaining ‘02 Sine wave voltage source’ parts to 

the line concentrator. 
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13. Repeat the above operation to connect the ‘00 Resistor (linear)’ parts to the line 
concentrator. Connect the ‘00 Resistor (linear)’ parts R1, R2, R3, and R4 to 1, 
2, 3, and 4, respectively. The two circuits diagrams below are equivalent. 

 

 
 
 
 
 
 
 
 

 
 

 

 

Eq
ui

va
le

nt
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6 Analysis Processes 

XTAP performs transient analysis (instantaneous-value analysis) and has a steady-
state initialization function to enable the transient analysis to start from the circuit’s 
steady-state condition. Either of two methods can be used for steady-state initialization: 
one defines the initial values of the dynamic-circuit elements by calculating the AC 
steady-state solutions; in the second, the initial values are set using a power-flow 
calculation to determine the steady-state condition of the generator and loads, and 
hence use the result to calculate the AC steady-state solutions. 
 
There are four types of XTAP analyses: 
① Transient analysis 
② Steady-state initialization → Transient analysis 
③ Power-flow calculation → Steady-state initialization → Transient analysis 
④ Frequency-characteristic calculation (frequency scan) 
 
Each type of analysis is described below. 
 
① Transient analysis 
This performs a standard analysis of instantaneous values, starting from a state where 
the power-source voltage or current is zero. 
 
② Steady-state initialization → Transient analysis 
The program calculates the AC steady-state solution, considering the unbalanced 
circuit conditions. Using these results as initial values, the analysis starts from the 
steady-state operation condition. This type of analysis specifies a negative value for 
the ‘Start time’ parameter for the sine and cosine wave voltage/current sources, to 
include them in the AC steady-state calculation. Power sources with waveforms other 
than sine or cosine are ignored in the AC steady-state calculation. 
 
③ Power-flow calculation → Steady-state initialization → Transient analysis 
The program uses a power-flow calculation (the ‘L method’) to determine the steady-
state solutions, ignoring harmonics or unbalanced circuit conditions. The solutions are 
used to analyze the AC steady-state solution to find approximations, considering 
unbalanced circuit conditions. These results are then used as the initial values for 
analysis away from the steady-state operation condition. ‘Power-flow calculation 
auxiliary parts’ are used to specify the power-flow conditions. 
 
④ Frequency-characteristic calculation (frequency scan) 
Analysis types ① to ③ are ultimately time-domain calculations (transient analyses). 
This calculation returns results in the frequency domain. The frequency f is varied within 
a specified range, and an AC steady-state calculation is performed repeatedly to 
determine the corresponding change in value. This type of analysis specifies a negative 
value for the ‘Start time’ parameter for sine and cosine wave voltage/current sources, 
so that these power sources may be considered in the AC steady-state calculation. 
Power sources with waveforms other than sine or cosine are ignored in the AC steady-
state calculation. 
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6.1 Analysis settings 
Conditions must be set to perform analyses. To do this, select ‘Analysis settings’ from 
the ‘Analysis’ menu in the main window. The method for setting analysis conditions is 
described in the procedure relevant to each analysis process. 
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6.2 Analysis procedure (analysis type: transient analysis) 
This section describes how to execute a standard transient analysis. As an example, 
we illustrate the analysis process using the PE-01.xsf file provided with XTAP. 
 
 
1. Select ‘Open’ – ‘Open circuit diagram’ from the ‘File’ menu in the main window, 

and select ‘PE-01.xsf’ from the ‘Open file’ screen. The PE-01.xsf file is located 
in work/templates/PE-01, in the folder where XTAP was installed. 

 
 
2. The following circuit diagram is then displayed. 
 

 
 
 
3. Select ‘Analysis settings’ from the ‘Analysis’ menu in the main window, or click 

the corresponding toolbar button. 
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4. The analysis settings screen appears. 
 

 
 

1 Analysis-file save location 
Specify the analysis filename (*.xtf file) and the save location. When the save 
location is specified as a relative path, this path is assumed to be expressed 
relative to the location of the circuit diagram file (*.xsf file). When the save 
location is specified as an absolute path, this path is used as the save location. 

 
2 Analysis-type selection 
Select the analysis type. In this example, ‘Transient analysis’ is selected. 

 
3 Analysis conditions 
Specify the analysis conditions corresponding to the analysis type. 

Case name: 
Specify the name of the analysis case. This will be used as the title when 
the analysis is graphed in XPLT. 
 
Calculation time increment: 
Specify the calculation time increment (Δt). 
 
Calculation end time: 
Specify the calculation end time. 
 
BNR switching iteration count: 
Specify the number of iterations for switching the convergence calculation 
from the standard Newton-Raphson method to the biaxial Newton-
Raphson method (this setting usually does not need to be changed). 
 
Katzenelson switching iteration count: 
Specify the number of iterations for switching from the biaxial Newton-
Raphson method to the Katzenelson method (this setting usually does not 
need to be changed). 
 
Calculation result output file: 
Specify the calculation output file name. By default, the save location is a 
relative path starting from the location of the circuit diagram file (*.xsf file). 
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When the save location is instead specified as an absolute path, this is 
then used as the save location. 
 
Output start time: 
Specify the time at which to start collecting the calculation output. 
 
Output end time: 
Specify the time at which to end collecting the calculation output. 
 
Output frequency: 
Specify the output sampling rate. 
 
Text format/CSV format calculation result output: 
Specifying ‘Yes (text format)’ outputs calculation results in text format 
(space-separated). Specifying ‘Yes (CSV format)’ outputs results in CSV 
format (comma-separated). 
 
Text format output file: 
Specify a file name when the calculation output is in text format. The save 
location is specified relative to the location of the circuit diagram file (*.xsf 
file). When the save location is specified as an absolute path, this path is 
then used as the save location. 
 
CSV format output file: 
Specify a file name when outputting calculation results in CSV format. The 
save location is a path specified relative to the location of the circuit 
diagram file (*.xsf file). When the specified save location is an absolute 
path, this path is used as the save location. 
 
Debugging level: 
Specify the debugging level. This setting is not normallyused by the user. 

 
5. Click the OK button in the screen. 
 
6. Save the circuit, then perform the analysis by selecting ‘Run analysis’ from the 

‘Analysis’ menu or by clicking the corresponding toolbar button. The analysis 
cannot execute if the circuit has been changed. (The ‘Run analysis’ menu item 
and corresponding toolbar button are then inactive and cannot be selected). 

 
7. The command prompt is displayed when the analysis is executed. 
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When the analysis ends normally, the message ‘Analysis complete’ appears. 
 

 
 
8. An error message is displayed if the analysis process ends with an error. If 

source of the error is in the circuit, the error message is output and displayed in 
the file ‘xcoremsg.out’. If the error originates from the control block, the error 
message is output and displayed in the file ‘dynamsg.out’. The message file is 
output to the save location of the analysis file (*.xtf file). 
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6.3 Analysis procedure (analysis type: steady-state 
initialization → transient analysis) 

This section describes how to perform a steady-state initialization by calculating AC 
steady-state solutions. As an example, we illustrate the analysis process using the 
SSW-01.xsf file provided with XTAP. 

 
1. Select ‘Open’ – ‘Open circuit diagram’ from the ‘File’ menu in the main window, 

and select ‘SSW-01.xsf’ from the ‘Open file’ screen. The SSW-01.xsf file is 
located in work/templates/SSW-01, in the folder where XTAP was installed. 
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2. Sets the parameters for steady-state initialization. Double-click the SIN wave voltage 
source to open the parameter setting window. To perform steady-state initialization, set 
“Start time” to a negative value in the parameter settings (any negative values are 
allowed). 

 

 
 
3. Select ‘Analysis settings’ from the ‘Analysis’ menu in the main window. 
 
4. The analysis settings screen then appears. 
 

 
  

Enter negative 
value 
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1 Analysis file save location 
Specify the analysis filename (*.xtf file) and the save location. The default 
setting is [Circuit diagram file name] + .xtf. When the save location is specified 
as a relative path, this path is assumed to be expressed relative to the location 
of the circuit diagram file (*.xsf file). When the save location is specified as an 
absolute path, this path is used as the save location. 

 
2 Analysis type selection 
Select the analysis type. For this example, select ‘Steady-state initialization → 
Transient analysis’ . 

 
3 Analysis conditions 
Specify the analysis conditions corresponding to the analysis type. All the items 
other than the three below are the same as for the transient analysis. 
 

System frequency: 
Specify the system frequency. This must be the same as the frequency of 
the power source in the circuit. A warning is output if the circuit contains a 
sine- or cosine-wave power source with a frequency different from this set 
frequency. 
 
Output power flow/steady-state analysis result output file: 
Setting ‘Yes’ outputs the steady-state analysis results. 
 
Power flow/steady-state analysis result output file: 
Specify a file name when outputting the steady-state analysis results. The 
default setting is [Circuit diagram file name] + _PFSS.txt. When the save 
location is specified as a relative path, this path is assumed to be 
expressed relative to the location of the circuit diagram file (*.xsf file). When 
the save location is specified as an absolute path, this path is used as the 
save location. 

 
5. Click the ‘Start calculation’ button on the screen. 

 
6. The command prompt is displayed when the analysis process is executed. 
 

 
 
When the analysis process ends normally, the message ‘Analysis finished.’ appears. 
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The results of the AC steady-state calculation are output as a text file. The AC 
steady-state solutions of the variables specified in the ‘Recording’ tab are output. 
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6.4 Analysis procedure (analysis type: power flow 
calculation → steady-state initialization → transient 
analysis) 

This section describes how to perform a steady-state initialization by calculating AC 
steady-state solutions, with steady-state conditions applied to the generators and loads, 
as determined by power-flow calculation (the ‘L method’). The steady-state initialization 
workflow is as follows: 
 
① Create the circuit diagram (a three-phase bus). 

↓ 
② Specify the power-flow conditions using power-flow-calculation auxiliary parts. 

↓ 
③ Set information-acquisition flags for the power-flow calculation using macro parts. 

↓ 
④ Execute the analysis. 
 
 
① Create circuit diagram 
The circuit diagram is created with the usual procedure, but the nodes and branches 
used to set initial values (synchronous generators or user-created macro parts) must 
be connected to a three-phase bus. See Section 5.6 for details of how to connect a 
three-phase bus. 
 
② Specify the power flow conditions using power-flow-calculation auxiliary 
parts 
Specify the power-flow conditions for each bus using power-flow-calculation auxiliary 
parts. These parts are located in the ‘20 Power flow calculation/steady-state 
initialization auxiliary parts’ section of the part category window. Use these parts to 
enter the initial values specified in the power-flow calculation. A power-flow-calculation 
auxiliary part should be connected to phase A of a three-phase bus. The reference 
capacity is specified in Step 4. This capacity is not the reference capacity for individual 
devices, and therefore care is needed when setting parameters. 
 
③ Use macro parts to set flags for acquiring power flow calculation information 
When connected to a three-phase bus, the following parts can use the results of a 
power-flow calculation (power-flow-calculation information) as parameters: 
 
Parts that can acquire power-flow-calculation information 
01 RLC 

 12 RX Parallel load model (single-phase) 
 13 RX Parallel load model 

 
07 Generator 

00 Synchronous generator  
 00 Synchronous generator (d1, q1, accounting for magnetic saturation) 
 01 Synchronous generator (d1, q2, accounting for magnetic saturation) 
 02 Synchronous generator (d1, q1) 
 03 Synchronous generator (d1, q2) 
 04 Synchronous generator (d1, q1, accounting for magnetic saturation and axis 

torque) 
 05 Synchronous generator (d1, q2, accounting for magnetic saturation and axis 

torque) 
 06 Synchronous generator (d1, q1, accounting for axis torque) 
 07 Synchronous generator (d1, q2, accounting for axis torque) 

 
07 Generator 

 00 Infinite bus generator 
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99 User's Components 
 (Arbitrary macro part) 

 
The part properties for the synchronous generators and infinite bus generators do not 
have a tab for power-flow-calculation information acquisition; this function is enabled 
by default. For arbitrary user-created macro parts, the choice to use power-flow-
calculation information can be set in the power-flow-calculation information tab. 
 
Parts that acquire power-flow-calculation information operate as follows: 
 

(1) During steady-state initialization, the part is removed from the three-phase bus. 
 
※1 When the generator bus of an auxiliary component for the power-flow calculation (slack 

generator bus, PV generator bus, PQ generator bus bar) is connected to the three-phase 
bus, a three-phase voltage source with the voltage and phase according to the power-
flow calculation result of the bus is automatically added. 

 
※2 When the load bus of an auxiliary component for the power-flow calculation (PV load 

bus, PQ load bus) is connected to the three-phase bus, the three-phase load with the 
voltage and phase according to the load flow calculation result of the bus is automatically 
added. 

 
※3 The “13 RX parallel load model” cannot be removed from the three-phase bus in the 

steady-state initialization calculation. Therefore, when the load bus of the auxiliary 
component for power-flow calculation is connected to the three-phase bus, both the RX 
parallel load model and the automatically-added three-phase load are considered in the 
steady-state initialization calculation. Therefore, if you want to remove the load model 
from the three-phase bus, please use “14 RX parallel load model (exclude enabled)” 
instead of “13 RX parallel load model”. 

 
(2) The following variables (parameters) can be used in the parameter fields and 

formula fields of part properties. The value is acquired from the three-phase bus 
to which the part is connected. 

 
Vbus  Bus voltage [V] 
theta_bus Bus voltage phase [rad] 
PGbus Bus generator active power [W] 
QGbus Bus generator reactive power [var] 
PLbus  Bus load active power [W] 
QLbus  Bus load reactive power [var] 
theta_shifted Phase difference from bus voltage reference phase [deg] 

 

 
  

Caution 
For synchronous generators and infinite bus generators, power-flow-
calculation information acquisition is enabled by default (and cannot be 
disabled). Problems such as information not being considered during steady-
state initialization, or initialization not being performed properly, can therefore 
occur when an analysis is performed without executing a power-flow 
calculation. When using these parts, the analysis type should therefore be set 
to the type that includes power-flow calculation. 



 

- 64 - 

④ Execute analysis 
Execute the analysis once the circuit has been created using Steps 1, 2, and 3. 
 
Below is an example of a power-flow calculation, steady-state initialization, and 
transient analysis using one of the templates (MAC-01) provided with XTAP. 
 
1. From the ‘File’ menu in the main window, select ‘Open circuit’. Then, select 

‘MAC-01-A.xsf’ from the ‘Open file’ screen. The file MAC-01-A.xsf is located in 
bin/work/templates/MAC-01, in the folder where XTAP is installed. 

2. The circuit diagram below then appears. 
 

 
 
3. Specify the generator power-flow conditions. 
Specify the conditions to be applied during the steady-state operation of the 
generator for the power-flow calculation. From the ‘part category’ window, select and 
use the part ‘07 Generator 00 synchronous generator’ in combination with either the 
part ‘20 Power flow calculation/steady-state initialization auxiliary parts－01 PV 
specification generator bus’ or ‘02 PQ specification generator bus’. The template is 
designated ‘PV’, specifying the generator output and generator terminal voltage. 
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4. Set the power-transmission-line impedance. 
Specify the impedance of the power-transmission line to be considered during the 
power-flow calculation. This calculation considers only the portions with a positive 
phase, and therefore only these portions can be specified in the parameters. 
 

         
 

Use the part ‘06 Line branch’ for a power-transmission line, and ‘07 Transformer 
branch’ for a transformer. 
 

5. Set the reference generator bus. 
One reference generator bus must be set. The part ‘07 Generator － 02 Infinite bus 
generator’ is normally used, combined with ’20 Power flow calculation/steady-state 
initialization auxiliary part － 00 Reference generator bus’. 
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6. Select ‘Analysis settings’ from the ‘Analysis’ menu in the main window. 
The analysis settings screen appears. 

 

 
 

1 Analysis-file save location 
Specify the analysis file (*.xtf file) name and the save location. The default 
setting is [Circuit diagram file name] + .xtf. When the save location is specified 
as a relative path, this path is assumed to be expressed relative to the location 
of the circuit diagram file (*.xsf file). When the save location is specified as an 
absolute path, this path is used as the save location. 

 
2 Selecting the analysis type 
Select the analysis type. For this example, ‘Power-flow calculation → Steady-
state initialization → Transient analysis’ is selected. 

 
3 Analysis conditions 
Specify the analysis conditions corresponding to the analysis type. All the items 
other than the following are the same as for the ‘steady-state initialization → 
transient analysis’ process. 
 

Reference capacity: 
Specify the reference capacity of the system. Note that this figure is not the 
reference capacity for each device. 

 
7. Click the ‘Start calculation’ button on the screen. 

 
8. The command prompt is displayed when the analysis is executed. 
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When the analysis ends normally, the message ‘Analysis complete’ appears. 
 

 
 
The results of the power-flow calculation are output as a text file. They can be used 
to check that the initial values specified in Steps 3 to 5 were used. 
 

 
 
9. An error message will be shown when an error occurs during the execution of 

the simulation.When the error is related to the circuit part, the details of the 
error will be displayed in the file “xcoremsg.out”. When the error is related to 
the control-system part, the details of the error will be displayed in the file 
“dynamsg.out”. When the error is related to the power-flow calculation, the 
details of the error will be displayed in the file “flowmsg.out”. All these file are 
located in the same folder of the simulation .xtf file. 
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6.5 Analysis procedure (analysis type: frequency 
characteristic calculation) 

The frequency-characteristic calculation is a function that calculates the response to a 
change in a power-source frequency in a circuit, between user-specified start and end 
values, in arbitrary increments. 
 
Consider a simple RLC series circuit as an example. 
 
1. Create a series circuit consisting of a power source, resistance, inductance, and capacitance 
as shown in the figure below. 
 

 
 
The calculated frequency characteristic is that produced by the power source ‘E_cos1’. 
Usable power sources may be of one of the following four types. Other power sources 
are treated as short-circuited (voltage sources) or open (current sources) in the context 
of the calculation. The usable power sources will also be treated as short-circuited 
(voltage sources) or open (current sources) if the setting described in Step 2 (entering 
a negative start time) is not entered. 
 

Sine wave voltage source Sine wave current source 
Cosine wave voltage source Cosine wave current source 

 
2. Set the parameters for the frequency-characteristic calculation. 
Double-click the power source to open the ‘parameter setting’ screen. Set ‘Start time’ 
to a negative value (any negative value is acceptable) to cause this power source to 
become recognized as the power source for implementing frequency variation. 
 

 

Enter negative value
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3. Select ‘Analysis settings’ from the ‘Analysis’ menu in the main window. 
The analysis settings screen appears. 

 

 
 
 

 
1 Analysis file save location 
Specify the analysis filename (*.xtf file) and the save location. The default 
setting is [Circuit diagram file name] + .xtf. When the save location is specified 
as a relative path, this path is assumed to be expressed relative to the location 
of the circuit diagram file (*.xsf file). When the save location is specified as an 
absolute path, this path is used as the save location. 

 
2 Analysis type selection 
Select the analysis type. For this example, select ‘Frequency characteristic 
calculation (frequency scan)’. 

 
3 Analysis conditions 
Specify the analysis conditions corresponding to the analysis type. 

 
Case name: 
Specify the analysis case name. This name is used as the title when the 
analysis is graphed in XPLT. 
 
Start frequency: 
Specify the starting frequency for the frequency-characteristic calculation. 
 
End frequency: 
Specify the end frequency. 
 
Frequency count: 
Specify the number of frequencies at which to perform the calculation 
between the start and end frequencies. 
 
Frequency sampling: 
Specify whether to use equal (linear) or log-scale sampling intervals. 
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Calculation result output file: 
Specify the output file name. When the save location is specified as a 
relative path, this path is assumed to be expressed relative to the location 
of the circuit diagram file (*.xsf file). When the save location is specified as 
an absolute path, this path is used as the save location. 
 
Text format/CSV format calculation result output: 
Specifying ‘Yes (text format)’ outputs the calculation results in text format 
(space-separated). Specifying ‘Yes (CSV format)’ outputs them in CSV 
format (comma-separated). 
 
Text format output file: 
Specify a file name when outputting calculation results in text format. When 
the save location is specified as a relative path, this path is assumed to be 
expressed relative to the location of the circuit diagram file (*.xsf file). When 
the save location is specified as an absolute path, this path is used as the 
save location. 
 
CSV format output file: 
Specify a file name when outputting calculation results in CSV format. 
When the save location is expressed as a relative path, this path is 
assumed to be expressed relative to the location of the circuit diagram file 
(*.xsf file). When the save location is specified as an absolute path, this 
path is used as the save location. 
 
Debugging level: 
Specify the debugging level. This setting is not normally used by the user. 

 
4. Click the ‘Start calculation’ button on the screen. 
 
5. The command prompt is displayed when the analysis process is executed. 

 

 
 
When the analysis process ends normally, the message ‘Analysis finished’ 
appears. 
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6.6 Files related to analysis processes 
This section describes the files used for analyses (*.xsf files) and those generated by 
analysis processes. 

 
*.xsf (XTAP schematic file) files 
These binary files store circuit diagrams to be analyzed. 
 
*.xpf (XTAP plot file) files 
These binary files store the analysis results. They can be used to display graphs with 
XPLT. 
 
xcoremsg.out 
This file contains errors and warning messages, generated during analysis, that relate 
to circuit areas. Generated errors are displayed automatically on the screen, but 
warnings unaccompanied by errors are not displayed automatically, and therefore 
require caution. 
 
dynamsg.out 
This file contains errors and warning messages, generated during analysis, that relate 
to control-block areas. Generated errors are displayed automatically on the screen, but 
warnings unaccompanied by errors are not displayed automatically, and therefore 
require caution. 
 
flowmsg.out 
The details of errors and warnings related to the power-flow calculation will be saved 
in this file. Errors will be automatically displayed in the screen when executing the 
simulation, however warning will not be automatically displayed. 
 
*.xtf (XTAP text file) files 
Text-format input data files that are generated from *.xsf files by the XTAP graphical 
user interface, and are read by the XTAP analysis program.# 
 
*.xmf (XTAP model file) files 
These files specify models (macro parts) included by *.xtf files. Like *.xtf files, *.xmf 
files are text files generated from *.xsf files by the graphical user interface.# 
 
*.xtf.pp (XTAP text file preprocessed) files 
These files are generated by the XTAP analysis program as intermediate process 
outputs.# 

 
Normally .xpf files, .hmtl files, .xtf files, .xmf files and xtf.pp files are located in the same 
folder as the .xsf schematic file. However, the location of .xpf files and .xtf files can be 
changed by changing options in the simulation setup. 

 
#Users do not need to reference these files. 

 
  



 

- 72 - 

6.7 Search function 
The search function can be used to find parts or other elements in a circuit diagram. 

 

 
 

 
Select ‘Search’ from the ‘Circuit’ menu or click the corresponding toolbar button to open 
the search screen. 

 

 
 

Search-screen items: 
1 is used to enter the target text string; 
2 starts the search; 
3 closes the window; 
4 makes the search case-sensitive when this checkbox is selected; 
5 lists the search results. Clicking a ‘Path name’ entry selects that part or element. 

If the selected search result is located within a macro part, the circuit diagram of 
that macro part opens to show the result. 

 

1 

4 

5 

2 3



 

- 73 - 

7 Consecutive-Analysis Function 

7.1 Overview of consecutive analysis function 
This function uses parameter settings derived from values such as analysis-circuit 
element values. The function calculation involves consecutively varying the parameter 
values. In addition, XTAP also has another function for calculating statistical switching 
surges (described in Chapter 8). 

 
 

7.2 Opening the consecutive-analysis settings window 
The setting for the consecutive-analysis can be made in the consecutive-analysis settings 
window. Select “Consecutive-Analysis Settings” from “Analysis” in the main menu. Or click 
the “Consecutive-Analysis Settings” icon in the toolbar. 
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7.3 Consecutive-analysis settings window 
This section describes the consecutive-analysis settings window. An example is shown 
in the following screenshot. 

 
 
 

 
 
1. General settings tab 
• used to set consecutive analysis. 
 
2. Statistical switching-surge calculation settings tab 
• used to set the statistical switching-surge calculation function (described in Chapter 
8). 
 
3. Matrix-size menu 
• used to specify the number of cases to be executed consecutively and the number of 
parameters to set. The data input screen changes according to the values specified 
here. Up to 1,000 cases and up to 100 parameters can be specified. The analysis can 
still proceed even if some of the specified cases and parameters are left blank. 
 
4. Run all/stop all menu 
• It is possible to select at once cases that will be executed and cases that will be 
stopped. By clicking on “Run all” all cases will be set to be executed. By clicking on 
“Stop all” all cases will be set to be stopped. Moreover, when selecting some case 
numbers (refer the item 10 shown below), this menu will be automatically changed to 
“Run Selected Cases” and “Stop Selected Cases” 
 
5. Analysis result process menu 
• contains the buttons used to run and set statistical processes (operations acquiring 
values such as the waveform maximum or average values), executed on multiple-
analysis results (described in Section 7.8). 
 
6. Close menu 
• closes the window. Clicking ‘OK’ closes the window with the entered settings applied. 
Clicking ‘Cancel’ closes the window without applying the changes. 
 
7. Formula area 

1 2 

3 

4 

10 

5 6 

11

7 

9 8 
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• displays the parameter input cell information. This area can also be used to input 
numerical values and formulas to be provided as parameters directly. 
 
8. Case number button  
• This button is used to select several cases at once. It can be used to setting to run or 
to stop several cases at once, for example. It is also possible to selected cases by 
using the Ctrl or Shift keys. 
 
9. Run/stop selection button 
• determines whether or not each case will be executed in a consecutive analysis. 
 
10. Parameter name input cells 
• used to enter parameter names (variable names). 
 
11. Parameter input cells 
• used to enter the numbers and formulas required as parameters. 

 
 
 

7.4 Setting the number of cases and of parameters 
Use the ‘matrix size’ menu to specify the number of cases and of parameters to execute 
consecutively. The number of parameter-setting cells then changes to match the 
specified number of cases and parameters. 
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7.5 Parameter input method 
 

1. The properties normally entered as values are entered as variables. In the 
example below, the voltage-source voltage is set as the parameter ‘Param_A’. 

 

 
 

 
 
Most of the properties (e.g., voltage, current, frequency, resistance, inductance, and 
the ‘switch ON’ time) of parts (e.g., power sources, resistors, and switches) can be set 
as parameters. However, note that variable names cannot be used for some properties, 
such as initial values (e.g., the initial current in an inductor or the initial voltage of a 
capacitor), file names of parts that reference external files, and properties of power-
flow-calculation auxiliary parts. 
 
● All properties that can be used as macro-part parameters are permitted. 
 
● Only alphanumeric characters (uppercase letters, lowercase letters or numbers) and 

underscores “_” can be used for the parameter names. 
 
● Note that auxiliary units (prefixes for units of measurement such as M, k, m, or μ) for 

values set as parameters in the properties input screen are ignored. 
 
● Note that a normal analysis is no longer possible if part-property parameters are set 

in order to run consecutive analysis (since values are not input for variables entered 
as parameters). 
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2. Enter the parameter name in the ‘Parameter name’ field. 
 

 
 
 
3. Enter the parameter value for each case. 
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Entering parameter values can be facilitated by copying the data sets for multiple cases 
from a spreadsheet program such as Excel, and pasting them into XTAP. 
 
 

  
 
 

 
 

A parameter or data-list information 
created in Excel can be copied and 
pasted as a block of multiple cells. 
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Parameter values can be entered using a formula syntax. The information in the 
formula area or a cell is interpreted as a formula when its first character is an ‘equals’ 
sign (=). Cells are referenced in R1C1 format. 
 
A reference in R1C1 format is entered as follows. A relative cell reference to the cell 
that is located one cell to the left of the current cell is written ‘RC[-1]’, where ‘R’ stands 
for ‘row’ and ‘C’ for ‘column’. The brackets [ ] specify the number of steps separating 
the referenced cell from the current cell, in the horizontal or vertical direction. Specifying 
‘R’ (row) without a number in brackets means that the referenced cell is in the same 
row as the current cell. ‘R[-1]’ signifies ‘one row up’, and ‘R[1]’ means ‘one row down’. 
Similarly, ‘C’ (the column), specified without a number in brackets, signifies that the 
referenced cell is in the same column as the current cell, ‘C[-1]’ signifies ‘one column 
to the left’, and ‘C[1]’ means one column to the right. Absolute cell references are 
specified without brackets. For example, ‘R1C1’ denotes the cell of the first row and 
first column. 
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Entering an ‘equals’ sign (=) in the formula area followed by a letter or text string 
displays a list of functions starting with the entered text. (Hovering the mouse cursor 
over the name of a function displays a tooltip with brief help information for that 
function.) 
 

 
 
 
 

7.6 Ending/canceling parameter settings 
When the parameter settings have been entered, click ‘OK’ in the ‘Close’ menu to apply 
the changes to the analysis circuit. (An analysis cannot be executed without first saving 
the circuit.) To cancel the editing of parameter input cells, click ‘Cancel’. The ‘X’ button 
at the top-right corner of the window performs the same operation as the ‘Cancel’ button. 
When analysis is executed (described later), the process stops in the error status if a 
parameter cell is missing a value. However, rows and columns left completely blank 
are automatically ignored; no error is generated if the specified number of cases and 
parameters exceeds the actual number of cases and parameters provided. 

 

  
 
 

Same as 
‘Cancel’ 
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7.7 Executing a consecutive analysis 
After entering the analysis settings and saving the circuit, press the toolbar button 
indicated below to execute the consecutive analysis. 

 

 
 

The following message appears if a text-format calculation output has been selected 
in the analysis settings. The file size may be large for such an output. To cancel an 
analysis, select ‘Yes’. To output the calculation results in text format using the set 
analysis settings, select ‘No’. If there is no problem, select ‘No’ to proceed with the 
calculation. 

 

 
 
 
 

The expected size of the calculation output file will be displayed. Check if there is 
sufficient hard-disk capacity before proceeding with the simulation. 
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When the calculation starts, a message is displayed indicating the case being currently 
executed. Cases for which the run/stop setting has been entered as ‘Stop’ are not 
executed. 
 

 
 
 

The following message appears when the analysis of all the cases has finished. 
 

 

 
 
 

The following files are then generated: 
 

 
Analysis file name_(case number).xtf 
• input data files (one for each case) in text format. 
 
Analysis file name_(case number).xtf.pp 
• files generated by the XTAP analysis program as intermediate process outputs. 
 
AUTOSUB.xmf 
• a data file containing the created circuit data in the form of macro parts (since 
macroing is required for using parameters). 
 
Analysis file name_(case number).xpf 
• binary files storing the analysis results (one file for each case). 
 
Analysis file name_all.csv 
• a file that contains the analysis results, and the file name and time for each case. 
These analysis results are used when performing statistical processes. 
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7.8 Statistical processes for analysis results 
The recorded waveform results of a consecutive analysis carried out on a set of cases 
can be loaded into XTAP to determine the following quantities: 
 

 Maximum (MAX) 
 Minimum (MIN) 
 Maximum absolute value (MAXABS) 
 Average (AVE) 
 Integral (INTEGRAL) 
 Effective value (RMS) (Frequencies are set in the PostProcessing.ini file.) 

 
● The PostProcessing.ini file is stored in the folder containing xgui.exe (normally 

C¥XTAP¥bin). 
 

The format used for writing values is as follows: 
 

  
 
 

In addition to the six above quantities, operations on the recorded waveforms can be 
implemented using DLL files, as required by the user. For details, see Appendix 3 in 
this manual, “Creating and Using DLL Files for Statistical Processes.” 

 
 

[PostProcessingSection] 
HZ=50 



 

- 84 - 

7.9 Executing statistical processes 
Statistical processes are executed from the ‘analysis-result process’ menu in the 
‘consecutive-analysis settings’ window. 

 
 

  
 
 

(1) Consecutive processing of analysis results 
 

  
 
Press the ‘analysis-result consecutive processing’ button to open the following screen. 
Select the file ([File name] + ‘all.csv’) containing the file names for all the waveform 
data, and click the ‘Open’ button. This operation can also be performed by double-
clicking on the file name. 
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Statistical processing is executed on each waveform file. 
 

 
 
 
The following window then appears, asking whether or not the calculation result files 
are to be deleted. Click ‘Yes’ to delete the files, or ‘No’ to retain the files, for example to 
create graphs. 

 
 
 
The statistical-process result files (*.csv) are output to the folder where the calculation 
was executed. The file containing the maximum-value (MAX) results is named 
[Analysis file name] + ‘_MAX.csv’. The files for the other results are named in a similar 
fashion. 
 

 
  

Files output by statistical processing calculations 
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The information contained in the file is shown below. This comprises the calculation 
results (one data item per waveform) for the analyzed waveforms, i.e., the waveforms 
that were selected for recording by ticking the appropriate checkbox and that were 
output to the *.xpf files. 
 

 
 
 
(2) Process settings 
 

  
 
Pressing the ‘process settings’ button opens the following window. Enter the process 
type, 32-bit DLL file name, 64-bit DLL file name, and function name. Particular DLL file 
names can be selected via the ‘Browse’ button. 
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In XTAP, the two dll files “PostProcessingLibrary32.dll” and “PostProcessingLibrary64.dll” 
are installed by default. They contain the six operations listed previously: maximum 
(MAX), minimum (MIN), maximum absolute value (MAXABS), average (AVE), integral 
(INTEGRAL), and effective value (RMS). Accordingly, to perform any of these six 
operations in statistical processing, they must be specified as shown below, to be 
executed in the consecutive-processing of analysis results. 
 

 
 
Rows, columns, and cells can be copied and pasted. 
 
When a user-created function has been created, it can be executed by: ① entering 
the analysis type name, ② specifying the created DLL, and ③ entering the function 
name defined in the created DLL. 
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7.10 Displaying analysis results in XPLT 
When XPLT is started after finishing statistical calculations, the calculation-result files 
are not automatically selected. The calculation-result files to be displayed can be 
entered in XPLT using the ‘Add file’ button. 

 

 
 

When displaying calculation results, produced by the consecutive-analysis function, in 
XPLT, the specifier ‘AUTOSUB/’ is added to the element name. 
 
 

 
 

Calculation result files are not selected, 
so use ‘Add file’ button to add them. 
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8 Statistical Switching-Surge Calculation Function 

8.1 Overview of statistical switching-surge calculation 
function 

The statistical switching-surge calculation function statistically analyzes the magnitude 
of an input surge overvoltage by randomly varying the breaker ON timing and 
performing many input-surge calculations. This analysis function automatically 
performs all these calculations. Specifically, it lets the user set parameter values that 
are related to the ON timing, perform many calculations automatically, and perform 
statistical processes on the analysis results. 

 
8.2 Opening the settings window for a switching-surge 

calculation 
Open the settings window for a switching-surge calculation by selecting the ‘Statistical 
switching-surge calculation settings’ tab in the ‘case setting’ window. 
  

 
 
1. Breaker-search menu 
• used to search for breakers (switch parts with breaker logic) in the circuit. 
 
2. Calculation case-count menu 
• used to specify the number of calculations to perform. 
 
3. Random number setting menu 
• selects the method of determining the breaker ON command timing for each case. 
The ON timing is determined from uniformly distributed random values. Either of the 
following two methods can be selected for generating these uniformly distributed 
random numbers: 
 

 Automatic: The seed value used to generate the random numbers is changed each time 
the analysis is executed. 

 Manual: The random numbers are calculated using a user-set seed value. 
 
4. ON command setting menu 
Using the timing from t = 0 until the fixed time T1 set here has elapsed as the reference, 
the ON command timing uniformly distributes the range of cycles found from the set 
power-source frequency. The random numbers in the distribution are the uniformly 
distributed random numbers set in the ‘random number setting’ menu (Item 3 above). 
 

 Fixed time T1: Specify the reference time for the breaker ON time. 
 Frequency: Specify the range of values. 

1 5 3 4 6 7 

2 
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5. Analysis menu 
• executes the analysis. 
 
6. Help menu 
• displays the help information (user manual). 
 
7. Close menu 
• saves the settings entered in this window upon clicking ‘OK’, or cancels them upon 
clicking ‘Cancel’. The ‘X’ button at the top-right corner of the window performs the same 
operation as the ‘Cancel’ button. 
 

8.3 Analysis example 
This section provides an example of a statistical surge-switching calculation for the 
following circuit consisting of three breakers. 

 

 
 
(1) Breaker search 
Click the ‘Breaker search’ button in the case setting window to search for breakers in 
the circuit. 
 

 
 
 
 
 
 
 
 

Displays names of 
retrieved breakers. 
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(2) Case number specification 
Specify the number of cases to calculate. 
 

 
 
 
(3) Random number setting 
Specify the method for calculating random numbers. When selecting the manual 
method, enter a seed value. 
 

 
 
 
(4) ON command settings 
Enter the values for the parameters that specify the breaker ON time. 
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(5) Breaker parameter input 
Enter the values for the parameters that determine the breaker ON timing. 
 

 
 
 

Fixed time T2: Specify the time lapse from the ON command until 
the breaker operates. 

Standard deviation σ: Specify the standard variation in the breaker 
operation time. 

Maximum deviation σmax: Specify the maximum standard variation. 
 

The breaker operates according to the following timing. 
 
 

 
 
(6) Analysis execution 
Click the ‘analysis execution’ button to execute the analysis. 
 
(7) Statistical processing of analysis results 
Statistical analysis starts automatically when the analysis ends. (For the consecutive 
analysis described in Chapter 7, the statistical analysis must be done manually. For 
the statistical switching-surge calculation, the program proceeds to statistical 
processing after the analysis has finished.) Click ‘Yes’ to start the statistical processing. 
The analysis and output files for this processing are the same as those described in 
Chapter 7. See Chapter 7 for further information. 
 

 
 

T2

Actual input time 
Normal distribution with standard 
deviation σ, centered about [Input 
command time] + T2  

Input command 
Uniform distribution from [T1] to [T1 + 1/f)]

Time 

(Constant) 
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9 XPLT (Graphing Program) 

9.1 Starting XPLT 
To start XPLT from XTAP, select ‘XPLT (graphing program)’ from the ‘Tools’ menu in the 
main window. 

 

 
 
The same operation can be performed by clicking the toolbar button indicated below. 
 

 
 
 

 
 

9.2 Selecting the analysis result files 
When XPLT starts, an analysis result file (*.xpf file) is selected if the analysis was 
executed before starting XPLT. Otherwise, or to select a different analysis result file or 
to add files, click ‘Add file’ and select the desired file from the ‘Open file’ window. 
 
Note that when attempting to select an analysis-result file for which the analysis was 
done without checking the ‘Recording’ option for any part, there will be no data to output. 
The message ‘No data to output’ therefore appears, and the analysis result file is not 
selected. 
 
Multiple analysis-result files can be selected, enabling the data from each file to be 
plotted onto a single graph. 
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9.3 Displaying graphs 
There are two types of graph displays: normal (plotting unmodified outputs) and 
modified (plotting modified outputs). The normal graph displays are themselves of two 
types: a transient-analysis graph display (with time on the horizontal axis), and a 
frequency-characteristic calculation graph display (with frequency on the horizontal 
axis). 

 

 
 

Calculation result executed 
before starting XPLT 

① Select graph result file

② Add blank graph 

③ Select item 

④ Select output to display (one or more) 

⑤ Click to create graph 
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(1) Normal graph display 
① Select a graph result file. Only one graph file can be selected. 
② Click the ‘Add graph’ button to add a graph area. Do not click this button when 

adding to a graph area that is already displayed. 
③ Select the item to display. 
④ Select the output to display. Multiple outputs can be selected by pressing the 

Control or Shift key. 
⑤ Click the ‘Graph’ button. 
 
The output from multiple result files can be displayed onto a single graph. To display a 
second output, select a different graph result file in Step 1 above, and plot it in the same 
graph area. The numerical labels shown in the legend below the graph (i.e., #1 and #2) 
refer to the numbers written to the left of the file names in the window. 

 
 
Loading and plotting large amounts of data are a slow process. When the number of 
data points exceeds the specified number, it is possible to omit some data points from 
the display (low-resolution mode), or to display all the data points (full-resolution mode). 
Low-resolution graphs are denoted by an asterisk after the file number in the label 
below the graph. 
 
 

 
 
 

 
 
The default setting is to cull points if there are 10,000 or more. To switch between low- 
and full-resolution modes, select ‘Tools’ from the ‘File’ menu, or click the corresponding 
toolbar button. The low-resolution mode is also described in Section 6.5. 

制
御
信

号

Graph result file numbers 

Asterisk (*) indicates 
graph is displayed in low 
resolution mode 
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(2) Graph display for the frequency-characteristic calculation 
When a frequency-characteristic calculation result file is selected, the words 
‘frequency characteristic’ are appended to the file name and the graph is created 
with frequency on the horizontal axis. The absolute value and phase are displayed 
on the vertical axis by default. The horizontal axis has a logarithmic scale if that 
option was chosen for frequency sampling. Modified graph displays are produced in 
the same way as normal graph displays. 
 
 
 

 
 
 

Indicates file is frequency 
characteristic result file 

Absolute value graph 

Phase angle graph 

Log-scale axis 
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(3) Modified graphing 
Modified graphs involve the 5 following actions. 
 

 
 
① Integration 
• displays the integrated result of the selected output. 
 
② Fourier transform 
• displays the Fourier transform of the selected output. The phase angle is also 
displayed when the ‘Phase angle display’ checkbox is checked. 
 
③ Fourier-series expansion (specified interval) 
• performs a Fourier-series expansion over a specified range of the selected data. The 
phase angle is also displayed when the ‘Phase angle display’ checkbox is checked. 
The calculation range is set with the endpoint determined automatically from the 
specified reference frequency once the starting point has been set (moved left or right). 
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④ Constants (a*f(t)+b) 
• multiplies the selected output by a specified constant a and adds a specified offset b. 
 

 
 
⑤ XY plot 
• selects two signals and plots a graph by using one as the horizontal axis and the 
other as the vertical axis (for instance, this can be used to render the i-Φ characteristics 
from the current and magnetic flux). Click the ‘Plot’ button to display the following 
screen. Select the signals here in the same way as on the main XPLT screen, and set 
them for use as the X and Y axes. 
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Only one signal may be selected for the X axis (once it is selected, the ‘X axis >’ 
button will be deactivated). Multiple signals may be selected for the Y axis. 
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Click the OK button to display an XY plot as shown below. 
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(4) Panel button operations 
 
 
 

 

Adds analysis-result files to the list. 

Adds one graph screen. 

After selecting items, click this button to 
create the graph. 

Selects the results to output. Hold down 
the Shift or Control key on the keyboard 
to select multiple results. 

Deletes the selected analysis-result file 
from the list. 

Deletes one graph screen. 

Click this button to display the result of 
integration or a Fourier transform of the 
displayed graph. 

Check/uncheck to enable/disable grid line 
display. 

Displays the added analysis-result 
files. This is used to select the file to 
graph when multiple files have been 
added. Only one file can be selected. 

Selects the item to be plotted. 
Only one item can be selected. 

Drag an item with the mouse to move the 
boundary line. 
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(5) Graph display area 
 

 
 
 
 
 
 

 
  

A white graph background indicates the currently 
selected data. A function can be plotted on the 
current graph by selecting it and clicking the 
‘Graph’ button. To load the graph into a different 
area, click the ‘Add graph’ button to create the new 
graph area. 

Check this checkbox to select the data if you 
want to save it in CSV format or copy it to the 
clipboard.

Graph area 

Plot area 
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9.4 Graph editing 
Select any waveform or the legend of the graph and right-click with the mouse to 
display a menu. The plot line then displayed with a thick line is the selected waveform. 
 
 

 
 
Change color 
The color of the selected curve can be changed. Select ‘Change color’ from the menu 
to open the ‘Color settings’ dialog. Select the desired color and click ‘OK’. The curve 
changes color accordingly. 
 
Change thickness 
You can change the line thickness of the selected curve. Select ‘Change thickness’ 
from the menu and select the desired thickness magnification. 
 
Change Line Pattern 
It is possible to change the line type of the plotted graph. Choose one line type (solid 
line, dash line, etc) from the menu options. 
 
Change Marker 
It is possible to add a marker to a waveform (the marker is set to ‘None’ by default). 
 
Marker Size 
You can set the marker size when adding markers to the waveform. 
 
Delete 
Selecting a curve in the graph by clicking on it gives it a thicker line width. Right-click 
and select ‘Delete’ from the menu to delete the selected curve. The graph area still 
remains even if all the curves have been deleted. To delete the graph area also, click 
the ‘Delete graph’ button in the panel on the right. 
 
Clear Selections 
This menu item deselects a selected curve, reverting its line width back to the normal. 
 
Low-resolution display 
This option switches the display of a curve from full to low resolution. This item cannot 
be selected when the curve is already displayed in low-resolution display mode. 
 
Full-resolution display 
This option switches the display of a curve from low- to full-resolution. This item cannot 
be selected when the curve is already displayed in full-resolution display mode. 
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Display numerical data 
This option displays the numerical values for the selected curve in a text editor 
(Windows Notepad (notepad.exe) by default). The numerical data are displayed in tab-
separated format, allowing copying and pasting to Excel or similar spreadsheet 
software. You can change the choice of text editor. (Windows Notepad is slow when 
displaying a large volume of data, so using a faster text editor is recommended.) 
 

 
 
Right-clicking away from a curve but still in the graph area displays a menu containing 
only the ‘Display numerical data’ item. Selecting this item displays the numerical data 
for all the curves in the graph. 
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Editing the properties list 
Clicking the ‘Graph properties’ tab at the bottom of the screen’s left panel activates the 
properties-list mode, which displays the properties list for the current graph. 
 

 
 
Maximum and minimum values can be set for the X- and Y-axes in the properties list. 
If different quantities (such as voltage and current) are plotted simultaneously on a 
single graph, the properties list for all the corresponding Y-axes are also shown. 
 
Clicking on the X- or Y-axis graph label while in properties-list mode allows a change 
of the corresponding measurement units. It is also possible to change the units of the 
X- or Y-axis by clicking the legend of the X- or Y-axis, respectively. 
 

 
 
 
 
 
 
 
 
 

Click the label to change units

Select the units
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9.5 Menus 
(1) File menu 

 

 
 
New 
This option erases all the currently displayed graph data and displays a new graph. 
 
Open template 
A template is a group of files containing generic patterns of presentation that can be 
used as models for creating graphs of the same type. A template must be created from 
individual template files before it can be used. To open template files, select ‘Open 
template’ from the ‘File’ menu in the main window. The following file-selection screen 
appears. The arrow button is used to move the file selected on the left to the list of files 
to be opened, on the right. 
 
 
 
 
 
 

 
 
 
 
 
 
Save to template/Save as to template 
After displaying the graphs, select one of these menu items to save the currently 
displayed graph items. 
 

  

Lists the names of files that can be 
used in templates. A circle to the left of 
a file name indicates the file exists. 
Folder names can be checked by 
scrolling the display with the scroll bar. 

When using all the files to 
create the graph, click this 
button to move all the files to 
the list on the right at once. 

Moves only the selected file 
to the list on the right. 

Used to select files not registered as 
templates. Displays new files in the list. 
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Page settings 
This option is used to specify the number of graphs printed per page (i.e., on one sheet 
of paper) and the page margins. 
 

 
 
Print preview 
A preview is shown of how the currently displayed graphs will appear when printed. 
 

 
 
Print 
The displayed graphs are printed. If any of the graphs have been checked, only the 
checked graphs are printed. 
 
Exit 
The application terminates. 
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(2) Tools menu 
 

 
 
Selection 
• enters the normal mode for selecting a waveform. Click this button to switch from the 
‘Enlarge waveform’ mode described below to the normal mode. 
 
Enlarge waveform 
• enters the mode for enlarging a waveform. This mode causes the mouse cursor to 
change to a magnifying glass. Drag any part of the graph to zoom in to that region. 
Right-click to return to the normal selection mode. 
 
Restore 
• restores an enlarged waveform display to the normal display. 
 
Display time difference 
• displays two markers on the graph (red and blue). Use the mouse to drag the markers 
to the waveforms you would like to focus on. The times and differences indicated by 
the two markers are displayed in the upper left corner of the graph. Select [Delete 
marker] to delete that marker. 
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Display waveform values 
Two ordinate value markers are displayed, showing the corresponding values and their 
difference. 
 

 
 
 
Change entire graph size 
• changes the display size of the entire graph. 
 

 
 
 
Reset all checkboxes 
• resets all checkbox settings for the graph selection states. 
 
 
Redraw graph 
• reloads the data files of the displayed graph and redraws the graph. If the data in the 
analysis result files (*.xpf files) have changed because a calculation was redone, the 
currently displayed graph contents can be replaced with the new analysis results. 
 
 
Save in CSV format 
• saves the selected graph in CSV format. Selecting this item displays the file-saving 
dialog, where the user can specify a filename. When saving multiple graphs, a CSV file 
is created for each graph. The output for a graph saved in CSV format is shown on the 
next page. Note that saving a low-resolution graph in csv format causes that data to be 
culled. In this case, “culled” will appear on the first line of that file, and “*” will be 
appended to the item name of the culled data. 
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Low-resolution display mode/Full-resolution display mode 
• switch between the low- and full-resolution display modes. The graph display 
toggles between these modes each time these items are selected. The current mode 
is displayed on the toolbar. 
 
Toolbar in low-resolution mode: 
 

 
 
Toolbar in full-resolution mode: 
 

 
 

Move up 
• Moves the currently active graph up one position. 
 
Move down 
• Moves the currently active graph down one position. 

  

Signal type 

Part name 

Analysis result file No. 
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(3) Graph menu 
 

 
 
 
Save graph image – Save to file 
• saves the current graph as an image file such as a metafile or bitmap file. 
 
 
Save graph image – Save to clipboard 
• copies the current graph to the clipboard in bitmap format or metafile format, allowing 
it to be pasted into, e.g., Microsoft Word or Excel. 
 
(4) Setup menu 
 
Setup 
• Opens the setup window, where it is possible to change the settings of XPLT. 
 

<Numerical data output settings> 

 
 
 

Program used for displaying numerical data 
In this option it is possible to choose the program used for displaying numerical 
data. By default, the program used for displaying numerical data is the notepad 
(notepad.exe), which is installed by default in Windows. However, when opening 
large files in notepad it takes a long time to show its contents. Therefore, it is 
recommended to use a lightweight text editor. 
 
Case name display setting when outputting numerical data 
In this option it is possible to choose to show the case name of the graph in the first 
row of the csv file, when outputting numerical data to a csv file. When the checkbox 
is checked, the case name will be shown. When the checkbox is not checked, the 
case name will not be shown (in this case, the first row will be the data label and 
the data will be outputted from the second row)  
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<Graph settings 1> 

 
 

Low-resolution display setting 
In this option it is possible to specify the total number of points that triggers the 
low-resolution display setting. By default, it is set to 10000 points. 
 
Phase display setting of frequency characteristic calculation result 
In this option it is possible to choose to display the phase information when plotting 
a frequency characteristic waveform. If the checkbox is checked, the phase will be 
displayed in the plot. If the checkbox is not checked, it will not be displayed. 

 

(5) Help menu 
 
About...  
• Displays the XTAP version information 
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(6) Toolbar 
 
 
 
 
 

 
 
 
 
 
 

Displays the waveform value difference 
(right axis) markers 

Displays the waveform value difference 
(left axis) markers 

Displays markers showing time 
difference.

Switches to enlarge waveform display 
mode

Switches to selection mode 

Opens a template. 

Erases markers.

Changes the size of the entire graph

Clears all checkboxes 

Replots the displayed graph 

Resets the graph display area 

Switches the plotting mode 
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10 Creating and Editing Macro Parts 

XTAP allows the creation (registering) of multiple circuit parts or control-block parts 
together as a single new part. Once a part is registered in this way, it can be reused as 
often as needed. When reused, its parameter values can also be changed. 

 
10.1 Packaging procedure (creating macro parts) 

A created circuit can be ‘packaged’ to create a new part (a ‘macro part’). 
 
1. Create a circuit diagram. Create appropriate terminals to connect the parts to 

each other by selecting the terminals from the ‘00 Installation/terminals’ part 
category, and placing them in the diagram. In the example circuit diagram shown 
below, a value calculated in the control system is passed to the electrical circuit 
as a voltage source. The ‘01 Terminal (circuit)’ part can be used to connect the 
terminals of electrical-circuit parts (circled in red below) to other circuits. The 
control-system terminals TIME1, PI, and ‘Frequency’ (circled in blue below) do 
not need to be connected to other parts; hence, use the ‘05 Terminating output 
terminal (control)’ part to prevent terminals from being automatically appended to 
these parts when the circuit is packaged. If the circuit contains a terminal that is 
not connected to an output terminal or terminating terminal, the corresponding 
terminal is automatically appended to that element when the circuit is packaged. 

 
 

  
 
 
Specifying part parameters with text strings enables them to be specified as macro-
part parameters once the circuit has been made into a macro part. In this example, a 
parameter is specified for the ‘Frequency’ terminal using the parameter name FREQ. 
 
It should be noted that only alphanumeric characters (uppercase letters, lowercase 
letters or numbers) and underscores “_” can be used for the parameter names. 
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The following example screen shot shows a variable named ‘Lval’ being specified for 
the parameter of an inductor. It is important to note that when a variable is specified for 
a parameter, the auxiliary units of that parameter (i.e., unit prefixes such as M, k, m or 
μ) are ignored. The value of Lval can be set from the macro part’s properties as 
described later, but for the present case, if Lval is set to 10.0E–3, the inductor value 
used in calculations will be 10.0E–3 [H] and not 10.0E–3 [mH]. 
 

 
 
 
2. Select the circuit area to be packaged. In this example, ‘Select all’ is selected from 

the ‘Edit’ menu to select the entire circuit diagram. The entire circuit can also be 
selected using the mouse. 

 

 
 
3. Select ‘Package’ from the ‘Circuit’ menu. 
 

 
 
This operation can also be performed by clicking the toolbar button indicated below. 
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4. The following screen appears, allowing the macro part to be registered in the part-
category window. Only the category ‘99 User's Components’ can be selected. A 
subcategory can be selected only if it has already been created. See Section 10.6 
for details of how to create and delete categories in the part-category window. 
Select the part name with which the macro part is to be registered, then click ‘OK’. 
In this example, the part name ‘Control SIN power source’ has been selected. 

 

 
 
 
5. Specify the caption name that will be used to label the macro part on the canvas. 

This may include upper- and lowercase letters, the underscore character (_), and 
numbers. Caption names may not start with a number and cannot contain 
Japanese characters or other Asian-width characters. 

 
 

 
 
 
Click ‘OK’ to create the macro part on the canvas. 
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The original part type determines how the terminals of the created part are handled, 
as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. The part created in the part-category window is registered. 

 

 
 

  

Terminal (circuit) parts become red square terminals. 

Input terminal (control) parts become yellow square 
terminals. 

Terminating terminal (circuit) parts and 
terminating output terminal (control) parts do 
not extend outside the part. 

Output terminal (control) parts become blue 
square terminals 
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If the part was created in a previously specified subcategory, it is registered in that 
subcategory. 
 

 
 

 
 
7 Method for setting parameters 
In Step 1, the parameter for the ‘Frequency’ part was entered using the text string 
FREQ, making it a parameter for the macro part. We here describe how to specify 
this parameter when using the macro part.  

       
 
 
 
 
 
 
 
 
 
Double-click on the macro part ‘Sin_Wave1’ to open its ‘parameter setting’ screen. 
Specify the value of the ‘Frequency’ parameter in Sin_Wave1 as 50.0, as shown 
below. As explained above, if the original circuit part enabled the selection of 
auxiliary units (prefixes for the unit of measurement such as M, k, m, etc.) prior 
to packaging, those auxiliary units are ignored when the parameter value is set 
in the macro part. 
 
 

 

 

Composition of macro part (Sin_Wave1) 
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10.2 Changing macro parts 
 

(1) Changing the circuits of macro parts placed in circuit diagrams 
This section describes how to change the circuit within a macro part that is placed in a 
circuit diagram. Changes made to macro-part elements are applied to all the parts 
contained in the circuit diagram (or macroed circuit diagram) that were created from 
that part. Changes are applied even to a new part that is introduced into the circuit 
diagram via the ‘part category’ window, provided that this change was made in the 
circuit diagram. (In the circuit diagram, the same macro parts all have the same 
configuration, and the configuration in the circuit diagram has priority). However, part 
configurations that are modified in the ‘part category’ window do not affect the original 
part configuration; thus, a part placed on another circuit canvas will retain the original 
configuration. 
 
1. Right-click the macro part you want to edit. The ‘macro part’ menu appears. 

Select ‘Edit packaged diagram’. 

 
 
2. The circuit diagram that the macro part was packaged from is displayed. The 

background color of the circuit-diagram canvas is gray, as when editing icons. 
 

 
 
3. Edit and save the circuit diagram. 
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(2) Changing circuits of macro parts registered in the ‘part category’ 
window 

 
The circuit of a macro part registered in the ‘part category’ window is edited as follows. 
 
1. Select ‘Open’ – ‘Open component’ from the ‘File’ menu, or click the toolbar 

button used to open files and select ‘Open component’. 
 

 
 
 

2. Select the macro part you want to edit, then click ‘Display part’. 
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3. The circuit diagram from which the macro part was packaged is displayed on a 
canvas with a blue background. 

 
 
 

 
 
4. Edit and save the circuit diagram. 
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10.3 Editing macro-part icons 
The icon of a created macro part is edited as follows. 
 
1. Select ‘Open’ – ‘Open component’ from the ‘File’ menu, or click the toolbar 

button used to open files and select ‘Open component’. 
 

 
 
 

 
 
2. Select the macro part you want to edit, then click ‘Display part’. 
 

 
 
The button operations are described below. 
 
Ok 
• opens the editing screen for the icon of the macro part. 
 
Property 
• used to register parameters/formulas, or change part caption names. 
 
Display part 
• displays the parts that compose the macro part (the original circuit diagram). This is 
used to change the circuit configuration or part parameters. 
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3. The icon-editing screen is displayed on a canvas with a blue background. 
 

 
 
The following operations can be performed in the icon-editing screen: 
 
 
Form (Z) menu (drawing objects) 
 

 
 
Select 
• selects a drawing object placed on the component canvas. 
 
Straight line 
• creates a straight line. 
 
Triangle 
• creates a triangle. 
 
Rectangle 
• creates a rectangle. 
 
Circle 
• creates a circle. 
 
Text string 
• creates a text string. 
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Line 
• creates a line. 
1. Select ‘Line’ from the ‘Form’ menu. 
2. Move the mouse cursor to the component canvas, and click the starting location. 
3. Drag the mouse to draw the line to the desired end location. 
4. Select ‘Select’ from the ‘Form’ menu. 
5. Double-click the created line to display its properties screen. Set the required 

property values to adjust the line features. 
 

 
 
Pen information 
Pen Width: sets the line thickness. 
Pen Color: sets the line color. 
 
Coordinate information 
Start point: sets the coordinates of the starting location. 
Endpoint: sets the coordinates of the end location. 
 
Arrows 
None (default): leaves the line without arrow ends. 
Start point: adds an arrow to the starting end of the line. 
Endpoint: adds an arrow to the endpoint of the line. 
Both: adds arrows to both ends of the line. 
 

Line 

Triang

Rectangl

Circle 

Text string 
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Triangle 
• creates a triangle. 
1. Select ‘triangle’ from the ‘Form’ menu. 
2. Move the mouse cursor to the component canvas, and click the location at which 

to create the triangle. A triangle is displayed. 
3. Select ‘Select’ from the ‘Form’ menu. 
4. Double-click the created triangle to display its properties screen. Set the 

required property values to adjust the triangle features. 
 

 
 
Pen information 
Pen Width: sets the line thickness. 
Pen Color: sets the line color. 
 
Fill information 
Fill: check this box to fill the triangle with the selected color. 
Fill color: sets the fill color. 
 
Coordinate information 
• sets the triangle corner coordinates. 
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Rectangle 
• creates a rectangle. 
1. Select ‘Rectangle’ from the ‘Form’ menu. 
2. Move the mouse cursor to the component canvas, and left-click at the desired 

location of the top-left corner of the rectangle. 
3. Drag the mouse to define the size of the rectangle. 
4. The rectangle is created when you stop dragging the mouse. 
5. Select ‘Select’ from the ‘Form’ menu. 
6. Double-click the created rectangle to display its properties screen. Set the 

required property values to adjust the rectangle features. 
 

 
 
Pen information 
Pen Width: sets the line thickness. 
Pen Color: sets the line color. 
 
Fill information 
Fill: check this box to fill the rectangle with the selected color. 
Fill color: sets the fill color. 
 
Coordinate information 
Top-left coordinates: sets the coordinates of the top-left corner. 
Width: sets the width. 
Height: sets the height. 
 
Rectangle shape 
Rectangle: defines a normal rectangle (square corners). 
Rounded rectangle: gives the rectangle rounded corners. 
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Circle 
• creates a circle. 
1. Select ‘Circle’ from the ‘Form’ menu. 
2. Move the mouse cursor to the component canvas, and left-click at the desired 

location of the top-left of the circle frame. 
3. Drag the mouse to define the size of the circle. 
4. A circle is created when you stop dragging the mouse. 
5. Select ‘Select’ from the ‘Form’ menu. 
6. Double-click the created circle to display its properties screen. Set the required 

property values to adjust the circle features. 
 

 
 
Pen information 
Pen Width: sets the line thickness. 
Pen Color: sets the line color. 
 
Fill information 
Fill: check this box to fill the circle with the selected color. 
Fill color: sets the fill color. 
 
Coordinate information 
Top-left coordinates: sets the coordinates of the top-left corner of the circle frame. 
Width: sets the width of the circle frame. 
Height: sets the height of the circle frame. 
 
Customize circle 
Make into arc: turns the circle into an arc when this box is checked. 
Start angle: sets the starting angle of the arc. 
Sweep angle: sets the sweep angle of the arc. 
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Text string 
• creates a text string. 
1. Select ‘Text string’ from the ‘Form’ menu. 
2. Move the mouse cursor to the component canvas, and click at the desired 

location of the text string. 
3. The cursor appears for entering text. 
4. Enter the desired text string. 
5. Select ‘Select’ from the ‘Form’ menu. 
6. Select the created text string and right-click to display a menu. Select ‘Properties’ 

from this menu to display the properties screen for the text string. Set the 
required property values to adjust the text-string features. 

 

 
 
Current font 
Click ‘Set’ to set the font. 
 

 
 
Coordinate information 
• specifies the coordinates of the center of the text string. 
 
Display orientation 
Normal: displays the text string normally. 
Right 90°: rotates the text string clockwise so that its left side is at the top. 
Left 90°: rotates the text string counterclockwise so that its left side is at the bottom. 
 
Caption 
• specifies the content of the text string. 
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10.4 Connection-terminal settings 
 
This section describes the screen for defining the settings of the part terminals. 
Terminals can be placed on the component canvas in the same way as when editing 
icons. Two parts are shown as examples in the screens below.. 

 

 
 
1. Terminals (default color: red) of an electrical-circuit part are used to connect one 

electrical-circuit part to another. 
2. Input terminals (default color: orange) of a control-system block part connect an 

input signal to the part. 
3. Output terminals (default color: blue) of a control-system block part connect to 

an output signal produced within the part. 
 

  

1
2 3 
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Form menu (terminals) 
 

 
 
 
Terminal 
• creates a terminal for an electrical-circuit part. 
 
Input terminal 
• creates an input terminal for a control-system block part. 
 
Output terminal 
• creates an output terminal for a control-system block part. 
 
Multiple-signal input terminal 
• creates a control system block part input terminal for handling vector signals 
 
Multiple-signal output terminal 
• creates a control system block part output terminal for handling vector signals 
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Terminal properties screen 
 
Double-click on a terminal or right-click on it and select ‘Properties’ from the menu that 
appears, to display the terminal’s properties screen. 

 

 
 
Terminal information 
Type: displays the terminal type (terminal, input terminal, output terminal). 
Terminal color: used to select the color of the terminal. 
 
Display orientation 
• selects the orientation of the terminal (horizontal or vertical). 
 
Coordinate information 
• specifies the coordinates of the terminal’s center. This must be entered in multiples 
of 4 (i.e., 0, 4, 8, etc.) since terminals are always placed on grid lines. 
 
Name 
• specifies the name used to manage the connection line (e.g., electric-circuit wire or 
control-system wire) connected to the terminal. 
 
Terminal number 
• specifies the output sequence of the terminal information output to *.xtf files (XTAP 
Text Files). Terminals numbers must be unique in parts. 
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10.5 Registering parameters/formulas 
 
Parameters and formulas can be registered in created macro parts. Once registered, 
a parameter or formula is entered when the macro part is set in the circuit diagram. 
 
1. Select ‘Open’ – ‘Open component’ from the ‘File’ menu, or click the toolbar 

button used to open files and select ‘Open component’. 
 

 
 

 
 
 

2. Select the macro part you want to edit, then click ‘Properties’. 
 

 
 
 
3. The part’s properties editing screen appears. 
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4. To register a parameter, select ‘SubParams’ under ‘Tag ID’ and enter the 
parameter value next to ‘Value’ under ‘Initial value’. This is demonstrated below for 
the parameter ‘b = 100’. 

 

 
 
 
5. To register a formula, select ‘SubExpression’ under ‘Tag ID’ and enter the formula 

next to ‘Value’ under ‘Initial value’. This is shown below for the formula ‘a = 5 * b’. 
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6. Click ‘Ok’ to close the properties screen. Click ‘Ok’ in the ‘Open component’ 
screen to close the component. 

 

 
 
 
7. When the macro part is placed in the circuit diagram and its properties are 

viewed, the registered parameter and formula are entered. 
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10.6 Part-category window composition; creating/deleting 
categories 

Categories can be created within the ‘99 User's Components’ category in the ‘part 
category’ window. Categories created within the ‘99 User's Components’ category or 
parts registered there can also be deleted. 
 
 
(1) Creating subcategories 
 
This section describes how to create categories in the part-category window. All user-
created categories are created as subcategories within the ‘99 User's Components’ 
category. 

 
1. Select ‘Create category’ from the ‘File’ menu. 
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2. The ‘category input’ screen appears. Enter the desired category name in the 
‘Category name’ field. To create another category within this category, specify 
the higher-level category name, followed by the lower-level category name, with 
the names separated by ‘¥’. The screen shot below shows the category ‘User1’ 
being created. 

 
 

 
 
 
 

 
 
 

(2) Deleting categories/macro parts 
 
To delete a created category, right-click on its name and select ‘Delete’ from the right-
click menu. If any parts have been registered in a category, they must all first be deleted 
before the category itself can be deleted. Parts are deleted by the same method as the 
one used for categories. 
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11 Other 

11.1 Starting XTLC (line constants calculation program) 
 
To start XTLC from XTAP, select ‘XTLC (line constants calculation program)’ from the 
‘Tools’ menu in the main window. 

 

 
 
The same operation can also be performed by clicking the toolbar button indicated 
below. 

 
 

 
Appendix 1 describes how to use XTLC. 

 
 

11.2 Starting XFIT (system identification program) 
 
To start XFIT from XTAP, select ‘XFIT (system identification program)’ from the ‘Tools’ 
menu in the main window. 

 

 
 
The same operation can also be performed by clicking the toolbar button indicated 
below. 

 
 

 
 

Appendix 2 describes how to use XFIT. 
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1 Introduction 
1.1 Overview 

The line-constants calculation program (XTLC) calculates the line constants 
referenced by the XTAP distributed-constant line model, by placing line conductors 
and using physical constants. It can also be used independently and specifically for 
line-constant calculations. Figure 1 outlines the basic operation. Further details of how 
to use each function are provided in the sections indicated. 

 
⚪ Line-constants calculation [XTLC] 

Creating new data: see Section 2. 
Using existing data: see Section 3. 

Line-type selection 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⚪ Use of constants data for distributed-constant line model [XTAP] 
 

 

 

 

 

Figure 1. Basic XTLC operation workflow 

● Line-placement data are contained in files used for calculating constants. They include 
physical information for each line, such as overhead-line pole information and buried 
cable locations. 

● Line model constant data contain saved line-constant information calculated by XTLC. 
They can be referenced by XTAP distributed-constant line parts. 
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constants data

Register line 
placement data 

Line 
placement 
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1.2 Main window 
The main window, that appears when XTLC is started, is the following. 
 

 

 

 

 

 

 

 

 

 

 

 

 

It consists of a menu bar, toolbar, and status bar, and an area for displaying line-
placement data. 
 

1.3 Menu bar and toolbar 
The XTLC menu bar is described below. 
 

File (F) menu 

  
  

Status bar 

Menu bar 

Toolbar 

Line placement data area 
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New 
● creates a new line-placement data file. The same operation can also be performed 
by clicking the toolbar button shown below. 

  
 

Open 
● loads an existing line-placement data file and opens it in the line-placement data 
input screen. The same operation can also be performed by clicking the toolbar 
button shown below. 

  
 

Close 
● closes the line-placement data input screen. 
 

Save 
● saves the line-placement data (replacing the old data with a newer version). The 
same operation can also be performed by clicking the toolbar button shown below. 

  
 

Save as 
● saves the line-placement data under a new user-defined name if required. 
 

Exit 
● terminates XTLC. 
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View (V) menu 
● enables or disables the display of the toolbar or status bar. 

  
Databases menu 
● opens the line/cable databases, letting the user search and edit line types already 
registered in the databases, and register new lines. See Section 5 for details of how 
to register a new line type. 

  
 

Overhead transmission line 
● opens the overhead-transmission-line database. 
 

Overhead distribution line 
● opens the overhead-distribution-line database. 
 
Cable 
● opens the cable database. 
 
Help (H) menu 

  
 
Instruction manual 
● gives access to this manual. 
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2 Creating New Line-Placement Data 
2.1 Selecting the line type 

Select ‘New’ from the ‘File’ menu in the menu bar, or click the  toolbar button. 
The ‘line-type selection’ dialog appears. 
 

 
 

Select the type of line-placement data to create, then click the ‘Select’ button. 

 
2.2 Entering line-placement data 

The line-placement data input screen is divided into areas for inputting line-
placement data and displaying them diagrammatically. The items specified in the 
input area differ for overhead lines and underground cables. 

 
The input area is used to enter line-placement data and the ground resistivity. The 
data are entered in the following steps: 
① Select the type. 

Select either ‘Erase’ or ‘Do not erase’. (Select ‘Erase’ if it is assumed that the 
full line is at zero potential. This item is not available in the case of an 
underground cable.) 

Line placement data input area

Line placement diagram display area 
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② Conductor No. (input not required) 
The conductor number is automatically assigned when the line type is specified 
(Item 3 below). (0 when selecting ‘Erase’ in the type selection.) 

③ Specify the line type. 
Double-click the ‘Line type’ item to specify a line type. The Line/cable database 
screen appears. Select the desired line or cable. 

 

 

 

 

 

 

 

 

If the desired line or cable does not exist, save the data and close the line-
placement screen. See Section 5 for details of how to register the desired line 
or cable in a line/cable database. After registering this line or cable, load the 
saved data and continue the procedure. (See Section 3 for details of how to 
load existing data.) 
 

④ Enter the line placement. 
● Overhead line 
Specify the conductor placement by entering the pole information in the line-
placement data. A distribution line does not involve poles or conductor-interval 
settings. 

 

 

 

 

 

 

 

  

EnterAdd automatically 
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To check conductor placement, click the ‘↓ Draw (check)’ button to draw the 
conductor placement in the line-placement diagram, as shown below. 

    
 

● Underground cable 
Specify the conductor placement by entering the buried cable positions and 
conduit-line information in the line-placement data. 

 

 

 

 

 

 

 

  

Enter

Add automatically 
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To check conductor placement, click the ‘↓ Draw (check)’ button to draw the 
conductor placement in the line-placement diagram, as shown below. 

    
⑤ Specifying a Twist group 

For a ‘Twist group’ (overhead line) or ‘Triplex group’ (underground cable), 
specify three lines or cables as a group by selecting the same group number 
for them. 

 
Example: Setting conductors 1 to 3 as Group 1, and 4 to 6 as Group 2. 

 

 

 

 

 

 

For a non-twist line, input a 0 under ‘Twist group’ or ‘Triplex group’. 
Since in the case of underground cables, the assumption is that each cable will be 
installed along the conduit lines, it is not possible to rigorously simulate situations 
where triplex cables are installed in a group along a single conduit line. When triplex 
cables are placed as underground cables, place three cables based on the 
assumption that all three phases of the triplex cable can be fit into the conduit line.  
Place in such a way that the three cables are attached in an equilateral triangle. 
 
⑥ Save the line-placement data. 

Select ‘Save’ from the ‘File’ menu on the menu bar, click the  toolbar button, 
or click the ‘Save’ button to save the data. To apply the updated information to 
the calculation, data must be saved before performing the line-constant 
calculation. 
The following operations can be performed in the line-placement data input 
screen: 

 

Group 1 

Group 2
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Selection 
Click the first cell in a row to select that row. 
 

 

 

 

The row is then selected. 
 

 

 

 

Multiple selection (continuous range) 
Hold down the Shift key on the keyboard and click the first cells of the first and last 
rows in the desired range. 
 

 

 

 

 

 

 

 

All the rows in that range will then be selected. 
 

 

 

 

 

 

 

Multiple selection (separate rows) 
Hold down the ‘Ctrl’ key on the keyboard and click the first cells of each required 
row. 
 

 

 

 

 

 

 

 

Click 

Selected 

First row 

Last row 

Selected 
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Only these rows will then be selected. 
 

 

 

 

 

 

Inserting 

Select the location at which to insert a new row. Press the ‘Insert’ key on the 
keyboard to insert a new row immediately above this location. 
 

 

 

 

Inserting a selected (copied) row 

Select the location at which to insert a new row. Press the ‘Alt’ and ‘Insert’ keys on 
the keyboard together to insert a new row immediately above this location. The new 
row has the same content as the row previously at this location. Conductor numbers 
are automatically changed. 
 

 

 

 

Delete 

Select one or more rows and press the ‘Delete’ key on the keyboard to delete them. 

 

 

 

 

 

 

Conductor numbers are automatically changed. 

 

 

 

 

 

Moving 

A single selected row can be moved up or down. Select the row and press ‘Alt’ and 
the ‘up arrow’ cursor key on the keyboard together to move the row upward. Similarly, 
use the ‘down arrow’ cursor key to move the row downward. Conductor numbers 
are automatically changed to handle the move. 

New row is inserted 

Copied row is inserted 
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2.3 Line-constant calculation 
Click the ‘Calculate’ button to perform the line-constant calculation. After creating or 
updating line placement data, the data must be saved before proceeding to the line-
constant calculation. 

 

 

The ‘calculation-type selection’ dialog appears. Select the type of calculation to 
perform. If twist or triplex are specified, the ‘Create fixed-constant line model’ and 
‘Create frequency-dependent line model’ items cannot be selected*. 
 
*For transmission lines with a three-phase twist, it is possible to simulate a fixed-parameter line 
constant line model by using ‘Three-phase twist line model (fixed-parameter)’ in the XTAP 
distributed-constant line parts. 

 
Different parameters are required for each of the selected calculation types. For 
example, when the frequency-dependent line model has been selected, the following 
screen appears. Enter the required parameters, then click ‘Run’ to start the line-
constant calculation. 

 

 

 

 

 

 

If either of the following items is selected, a ‘file selection’ dialog appears when the 
calculation finishes. The file selected in the dialog is then used to save the line-model 
data for use by XTAP. 

● Create π-type equivalent circuit model 
● Create fixed-constant line model 
● Create frequency-dependent line model 
●Matching resistance 

Enter a file name, then click ‘Save’. 

 

Select unit: 
● m 
● km 

Select unit: 
● Hz 
● kHz 
● MHz 
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2.4 Displaying line-constant calculation results 
Line-constant calculation results are displayed in the ‘Line-constant calculation results’ 
or ‘Plot dialog’ screen. One of these screens appears when the line-constant 
calculation ends. 

①  Line-constant calculation results 
This displays the line-constant calculation results. If ‘Constant calculation only’ or 
‘Create frequency-dependent line model’ was selected in Section 2.3, the ‘Plot 
dialog’ described below in Item 2 is displayed first, and then the ‘Line-constant 
calculation results’ screen appears when this dialog is closed. 

   
 

If ‘Constant calculation only’ or multiple ‘Specified frequency’ values were 
previously specified, only the result calculated first is displayed. To display all the 
frequency results, check the *.mat file located in the same folder as the result file. 
They can then be checked using MATLAB. To save the calculation results, select 
‘Save’ from the ‘File’ menu. Alternatively, select ‘Copy all’ from the ‘Edit’ menu to 
save the results by pasting them into external software. 

 

   

   
Table 1 shows the line constant list displayed in the ‘Line constant results’. Refer 
to the following documentation for details regarding each constant. 

 

[1] Central Research Institute of Electric Power Industry (CRIEPI) Research 
Report H04014, “Development of a Line Constants Calculation Program for 
Overhead Transmission Lines - An eigenvector normalization algorithm and 
an approximate formula for ground-return impedance –” (can be downloaded 
from CRIEPI’s Web site) 
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Table 1  Line constant list 

 

 
  

------------------------------------------------------------------------ Characteristic impedance Z0 in phase coordinates [ohm]
  Real part:

Frequency =  5.00000E+001 [Hz]    3.56699E+002   9.46781E+001   6.08974E+001
   9.46781E+001   3.54126E+002   9.46781E+001

------------------------------------------------------------------------    6.08974E+001   9.46781E+001   3.56699E+002
  Imaginary part:

PHASE DOMAIN QUANTITIES (before ground-wire elimination)   -3.58050E+001  -1.88627E+001  -1.77957E+001
  -1.88627E+001  -3.60287E+001  -1.88627E+001

Space inductance Ls in phase coordinates [H/m]   -1.77957E+001  -1.88627E+001  -3.58050E+001
   1.15332E-006   2.86656E-007   1.63786E-007   3.72004E-007   1.95357E-007
   2.86656E-007   1.15332E-006   2.86656E-007   3.03782E-007   3.03782E-007 ------------------------------------------------------------------------
   1.63786E-007   2.86656E-007   1.15332E-006   1.95357E-007   3.72004E-007
   3.72004E-007   3.03782E-007   1.95357E-007   1.81650E-006   2.58400E-007 MODAL DOMAIN QUANTITIES (before eigenvector rotation)
   1.95357E-007   3.03782E-007   3.72004E-007   2.58400E-007   1.81650E-006

Series impedance z in modal coordinates [ohm/m]
Ground-return impedance Ze (including Ls) in phase   Real part:
  Real part:    1.91824E-004   3.84136E-005   3.66652E-005
   4.71730E-005   4.71656E-005   4.71435E-005   4.68207E-005   4.67989E-005   Imaginary part:
   4.71656E-005   4.71730E-005   4.71656E-005   4.68167E-005   4.68167E-005    6.66733E-004   3.14302E-004   2.62509E-004
   4.71435E-005   4.71656E-005   4.71730E-005   4.67989E-005   4.68207E-005
   4.68207E-005   4.68167E-005   4.67989E-005   4.64762E-005   4.64600E-005 Shunt admittance y in modal coordinates [S/m]
   4.67989E-005   4.68167E-005   4.68207E-005   4.64600E-005   4.64762E-005   Real part:
  Imaginary part:   -6.45612E-012  -5.66088E-025  -1.93744E-011
   5.61990E-004   2.87882E-004   2.44337E-004   3.06716E-004   2.47195E-004   Imaginary part:
   2.87882E-004   5.61990E-004   2.87882E-004   2.84512E-004   2.84512E-004    2.50197E-009   3.60544E-009   4.21510E-009
   2.44337E-004   2.87882E-004   5.61990E-004   2.47195E-004   3.06716E-004
   3.06716E-004   2.84512E-004   2.47195E-004   7.52239E-004   2.60287E-004 Propagation constants gamma in modal coordinates [1/m]
   2.47195E-004   2.84512E-004   3.06716E-004   2.60287E-004   7.52239E-004   Real part:

   1.82258E-007   6.49314E-008   7.08599E-008
Conductor internal impedance Zc in phase coordinates [ohm/m]   Imaginary part:
  Real part:    1.30484E-006   1.06650E-006   1.05462E-006
   3.52761E-005   3.52761E-005   3.52761E-005   2.93027E-004   2.93027E-004
  Imaginary part: Propagation velocities in modal coordinates [m/s]
   1.93711E-006   1.93711E-006   1.93711E-006   5.78691E-006   5.78691E-006    2.40765E+008   2.94571E+008   2.97887E+008

Total series impedance Z in phase coordinates [ohm/m] Characteristic impedance z0 in modal coordinates [ohm]
  Real part:   Real part:
   8.24491E-005   4.71656E-005   4.71435E-005   4.68207E-005   4.67989E-005    5.21332E+002   2.95802E+002   2.50119E+002
   4.71656E-005   8.24491E-005   4.71656E-005   4.68167E-005   4.68167E-005   Imaginary part:
   4.71435E-005   4.71656E-005   8.24491E-005   4.67989E-005   4.68207E-005   -7.41909E+001  -1.80093E+001  -1.79606E+001
   4.68207E-005   4.68167E-005   4.67989E-005   3.39503E-004   4.64600E-005
   4.67989E-005   4.68167E-005   4.68207E-005   4.64600E-005   3.39503E-004 Voltage transformation matrix Tv (v_phase = Tv*v_mode)
  Imaginary part:   Real part:
   5.63927E-004   2.87882E-004   2.44337E-004   3.06716E-004   2.47195E-004    5.79195E-001  -7.07107E-001  -3.68007E-001
   2.87882E-004   5.63927E-004   2.87882E-004   2.84512E-004   2.84512E-004    5.73639E-001  -7.46545E-015   8.53889E-001
   2.44337E-004   2.87882E-004   5.63927E-004   2.47195E-004   3.06716E-004    5.79195E-001   7.07107E-001  -3.68007E-001
   3.06716E-004   2.84512E-004   2.47195E-004   7.58026E-004   2.60287E-004   Imaginary part:
   2.47195E-004   2.84512E-004   3.06716E-004   2.60287E-004   7.58026E-004   -1.94289E-016  -1.11022E-016  -2.82716E-003

   2.47400E-003  -3.62296E-017   0.00000E+000
Space capacitance Cs in phase coordinates [F/m]    0.00000E+000   0.00000E+000  -2.82716E-003
   1.08700E-011  -1.96320E-012  -6.06465E-013  -1.76637E-012  -4.65239E-013
  -1.96320E-012   1.12047E-011  -1.96320E-012  -1.10364E-012  -1.10364E-012 Current transformation matrix Ti (i_phase = Ti*i_mode)
  -6.06465E-013  -1.96320E-012   1.08700E-011  -4.65239E-013  -1.76637E-012   Real part:
  -1.76637E-012  -1.10364E-012  -4.65239E-013   6.79219E-012  -4.96389E-013    6.05018E-001  -7.07107E-001  -4.06454E-001
  -4.65239E-013  -1.10364E-012  -1.76637E-012  -4.96389E-013   6.79219E-012    5.21512E-001  -5.02228E-015   8.20769E-001

   6.05018E-001   7.07107E-001  -4.06454E-001
Shunt admittance in phase coordinates [S/m]   Imaginary part:
  Real part:   -2.17105E-003  -4.80084E-016  -2.94431E-004
   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000    2.13498E-003   8.63732E-016  -2.94526E-003
   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   -2.17105E-003  -5.91107E-016  -2.94431E-004
   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000
   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000 ------------------------------------------------------------------------
   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000   0.00000E+000
  Imaginary part: MODAL DOMAIN QUANTITIES (after eigenvector rotation)
   3.41492E-009  -6.16757E-010  -1.90527E-010  -5.54921E-010  -1.46159E-010
  -6.16757E-010   3.52006E-009  -6.16757E-010  -3.46718E-010  -3.46718E-010 Series impedance z1 in modal coordinates [ohm/m]
  -1.90527E-010  -6.16757E-010   3.41492E-009  -1.46159E-010  -5.54921E-010   Real part:
  -5.54921E-010  -3.46718E-010  -1.46159E-010   2.13383E-009  -1.55945E-010    1.90103E-004   3.84136E-005   3.54574E-005
  -1.46159E-010  -3.46718E-010  -5.54921E-010  -1.55945E-010   2.13383E-009   Imaginary part:

   6.67223E-004   3.14302E-004   2.62672E-004
------------------------------------------------------------------------

Shunt admittance y1 in modal coordinates [S/m]
PHASE DOMAIN QUANTITIES (after ground-wire elimination)   Real part:

   0.00000E+000   0.00000E+000   0.00000E+000
Total series impedance Z in phase coordinates [ohm/m]   Imaginary part:
  Real part:    2.50200E-009   3.60544E-009   4.21517E-009
   8.79763E-005   5.18901E-005   4.95627E-005
   5.18901E-005   8.79618E-005   5.18901E-005 Characteristic impedance z01 in modal coordinates [ohm]
   4.95627E-005   5.18901E-005   8.79763E-005   Real part:
  Imaginary part:    5.21519E+002   2.95802E+002   2.50197E+002
   4.16443E-004   1.39217E-004   1.02141E-004   Imaginary part:
   1.39217E-004   4.11339E-004   1.39217E-004   -7.28452E+001  -1.80093E+001  -1.68105E+001
   1.02141E-004   1.39217E-004   4.16443E-004

Voltage transformation matrix Tv1 (v_phase = Tv1*v_mode)
Shunt capacitance C in phase coordinates [F/m]    5.79194E-001  -7.07107E-001  -3.68012E-001
   1.08700E-011  -1.96320E-012  -6.06465E-013    5.73641E-001  -7.46545E-015   8.53887E-001
  -1.96320E-012   1.12047E-011  -1.96320E-012    5.79194E-001   7.07107E-001  -3.68012E-001
  -6.06465E-013  -1.96320E-012   1.08700E-011

Current transformation matrix Ti1 (i_phase = Ti1*i_mode)
Shunt admittance Y in phase coordinates [S/m]    6.05016E-001  -7.07107E-001  -4.06450E-001
  Real part:    5.21505E-001  -5.05808E-015   8.20768E-001
   0.00000E+000   0.00000E+000   0.00000E+000    6.05016E-001   7.07107E-001  -4.06450E-001
   0.00000E+000   0.00000E+000   0.00000E+000
   0.00000E+000   0.00000E+000   0.00000E+000 Imaginary part of Tv1 which will be discarded
  Imaginary part:   -7.47278E-004  -3.25177E-017  -1.98140E-003
   3.41492E-009  -6.16757E-010  -1.90527E-010    1.73388E-003  -3.62296E-017  -1.96240E-003
  -6.16757E-010   3.52006E-009  -6.16757E-010   -7.47278E-004  -7.85046E-017  -1.98140E-003
  -1.90527E-010  -6.16757E-010   3.41492E-009

------------------------------------------------------------------------
Propagation constants Gamma in phase coordinates [1/m]
  Real part: SYMMETRICAL COMPONENTS
   1.07247E-007   3.33391E-008   4.23153E-008
   3.85996E-008   1.03556E-007   3.85996E-008 Positive-Sequence Impedance [ohm/km]
   4.23153E-008   3.33391E-008   1.07247E-007   Real part:
  Imaginary part: 3.69E-02
   1.14810E-006   7.57169E-008   8.16053E-008   Imaginary part:
   8.68693E-008   1.12976E-006   8.68693E-008 2.88E-01
   8.16053E-008   7.57169E-008   1.14810E-006

Zero-Sequence Impedance [ohm/km]
  Real part:
1.90E-01

  Imaginary part:
6.68E-01

------------------------------------------------------------------------

Phase domain constant (before GW elimination)

Phase domain constant (after GW elimination) 

 Modal domain constant  
(before transformation matrix normalization)

 Modal domain constant  
(after transformation matrix normalization)

Space inductance 

Ground-return impedance 

Conductor internal impedance 

Line series impedance

Space capacitance 

Line parallel admittance 

Line series impedance 

Line parallel admittance 

Line parallel capacitance 

Propagation constant 

Characteristic impedance 

Line series impedance 

Line parallel admittance 

Propagation constant 

Propagation speed

Characteristic impedance 

Voltage transformation matrix 

Current transformation matrix 

Line series impedance 

Line parallel admittance  

Characteristic impedance 

Voltage transformation matrix 

Current transformation matrix 

Imaginary part of voltage transformation matrix 

 Symmetrical components  
(only displayed in case of three-phase line) 

Positive-sequence-phase impedance 

Zero-sequence-phase impedance 
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If the results screen is closed without saving, a ‘save confirmation’ dialog appears. 
Click ‘Yes’ to save the results. 

 

 

 

 

 

 

② Plot dialog 
The ‘Plot dialog’ appears if ‘Constant calculation only’ or ‘Create frequency-
dependent line model’ was selected in Section 2.3. 

a. ResView1 
This is displayed when the item below is selected as the calculation type, but not 
when only one frequency has been specified. 

● Constant calculation only 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each ‘Plot’ buttons displays the corresponding plot. 
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⚪ Damping constant and propagation-velocity frequency response 
 

 

 

 

 

 

 

 

 

 

 

⚪ Characteristic-impedance frequency response 
 

 

 

 

 

 

 

 

 

 

⚪ Voltage transformation matrix frequency response 
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b. ResView2 

This is displayed when the following item is selected as the calculation type. 
● Create frequency-dependent line model 

This dialog allows checking of the model precision by comparing the frequency 
characteristics of the calculated line constant and of a frequency-dependent 
model created by fitting it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each ‘Plot’ buttons displays the corresponding plot. 
 

⚪ Characteristic admittance matrix [Y0] fitting results 

The graphs for the specified row or column are displayed. 
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⚪ Characteristic admittance matrix [Y0] eigenvalue frequency characteristics 
(stability evaluation) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⚪ Propagation function matrix [H] fitting results 

The graphs for the specified row or column are displayed. 
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3 Referencing Existing Line-Placement Data 
3.1 Referencing line placement data 

Select ‘Open’ from the ‘File’ menu on the menu bar, or click the  toolbar button. 
The ‘file selection’ dialog appears. Select a line-placement data file (*.lin file). 

 
 

3.2 Revising line-type information 
To revise a line type, double-click on the line type. 
 

 

 

 

 

 

 

The ‘line/cable database’ screen appears. Select the desired line type. 
 

 

 

 

 

 

 

 

 

 

If the desired line type does not exist, save the data and close the line-placement 
screen. Register the line type in the line/cable database (see Section 5), then load 
the saved data and continue the procedure. 
 

3.3 Calculating line constants and displaying results 
See Sections 2.3 and 2.4. 
 

Double-click
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4 Using Line Model Data Created in XTLC 
4.1 How to specify the data for the distributed-parameter line 

model 
The following distributed-line constant parts can be used for created line-model 
data: 
● 01 π-type equivalent-circuit line model (XTLC) 

● 03 Fixed-parameter distributed-constant line model (XTLC) 

● 04 Frequency-dependent distributed-constant line model 

  
 

Click ‘Browse’ in the ‘parameter setting’ screen to select line-model data. It is also 
necessary to specify the number of phases (number of conductors) for the selected 
line model data along with the line length. (It is not necessary to specify the line 
length in the case of a distributed constant line model that is dependent on 
frequency). 
 

 

 

 

 

 

 

 

 

 

If the following message appears when clicking ‘Browse’, select ‘Save as’ from the 
‘File’ menu on the menu bar to save the circuit diagram. 
 

 

 

 

An example is shown below. 
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● Overhead line example 

When a conductor placement in XTLC as shown in the figure on the left below is 
specified and then calculations are executed by selecting the π type equivalent 
circuit model ,line model data is created as shown in the figure on the right below. 

 

   
 

 

 

 

 

 

 

This example has three conductors and three phases. Therefore, specify ‘3’ as the 
number of phases in the parameter setting screen. Select the line-model data above 
as the data file. 
 

 

 

 

 

 

 

 

 

 

 

 

The number of part terminals in the circuit diagram is then updated to 3. The terminal 
sequence is the conductor number sequence specified in XTLC. 

  



 

- 165 - 

    

● Cable example 

When a conductor placement in XTLC as shown in the figure on the left below is 
specified and calculations are executed by selecting the fixed-constant line model, 
line model data is created as shown in the figure on the right below. 

    
 

This example has three conductors and three phases, with each phase consisting 
of a core-and-sheath combination. Therefore, specify ‘6’ as the number of phases 
in the parameter setting screen. Select the above line-model data as the data file. 

  

Conductor No. 1 

Conductor No. 2 

Conductor No. 3 
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The number of part terminals in the circuit diagram is then updated to 6. The terminal 
sequence is the conductor number sequence specified in XTLC. For each conductor, 
the core is set first, then the sheath. 

     

Conductor No. 1 core 
Conductor No. 1 sheath 
Conductor No. 2 core 
Conductor No. 2 sheath 
Conductor No. 3 core 
Conductor No. 3 sheath 
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4.2 How to specify the data for matching resistance 
The created model data of the matching resistance can be used by using the 
following component. 

● 07 Matching Resistance 

You can set the model data file to this component by selecting “Choose file”, in the 
parameter screen. Note that it is necessary to choose the number of phases used 
in the selected model data. 

When the following screen appears when you click on “Choose file”, it is necessary 
to save the circuit schematic file by clicking on File > Save as, in the menu bar. 

 
 

● Example using an overhead line 

Specify the line position parameters in XTLC, like the figure below, then click on the 
button “Calculate”. Finally, choose “Matching Resistance” in the window that appears 
on the screen. After the calculation ends, the data about the matching resistance 
matrix will be displayed on the screen, like the figure below. 
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Go back to XTAP and place the component “07 Matching Resistance” on the circuit 
schematic file and save it. In this example a 3-phase 3-conductors line is considered, 
therefore the parameter “Number of phases” of the XTAP component “07 Matching 
Resistance” is set to “3”. Moreover, the data file calculated by XTLC is chosen in the 
“Data file” parameter.  

 
After you set these values and close the properties screen of the component, the 
number of terminals on each side of the component will be updated to be three. 
Moreover, the order of the terminals is the same order as specified in XTLC. 

 
 

● Example using an underground cable 

Specify the cable position parameters in XTLC, like the figure below, then click on the 
button “Calculate”. Finally, choose “Matching Resistance” in the window that appears 
on the screen. After the calculation ends, the data about the matching resistance 
matrix will be displayed on the screen, like the figure below. 

Conductor No. 1 

Conductor No. 2 

Conductor No. 3 
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Go back to XTAP and place the component “07 Matching Resistance” on the circuit 
schematic file and save it. In this example a 3-phase 3-conductors line is considered, 
however for each cable its core and its sheath are considered separately. Therefore, 
it is necessary to set the parameter “Number of phases” of the XTAP component “07 
Matching Resistance” to “6”. Moreover, the data file calculated by XTLC is chosen in 
the “Data file” parameter.  

 
After you set these values and close the properties screen of the component, the 
number of terminals on each side of the component will be updated to be six. Moreover, 
the order of the terminals is the same order as specified in XTLC. However, for each 
cable its core and its sheath are considered as different phases 
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Conductor No. 1 core 
Conductor No. 1 sheath 

Conductor No. 2 sheath 
Conductor No. 2 core 

Conductor No. 3 core 
Conductor No. 3 sheath 
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5 Registering Information in Line/Cable Databases 

This section describes how to register information in line/cable databases. Before 
registering information, close the line-placement screen if it is open. 
 

5.1 Databases 
There are six line/cable databases: 
⚪ Developer-provided databases 
● Overhead transmission lines: Overhead transmission lines.cbl 
● Overhead distribution lines: Overhead distribution lines.cbl 
● Underground cables: Underground cables.cbl 
⚪ Databases for users 
● Overhead transmission lines: Overhead transmission lines (for users).cbl 
● Overhead distribution lines: Overhead distribution lines (for users).cbl 
● Underground cables: Underground cables (for users).cbl 
Searches are the only operation that can be done on developer-provided databases. 
These databases cannot be updated by adding or deleting information. Databases 
for users can have new or edited information registered in them. You can edit 
developer-provided information by searching for the required information and then 
performing the ‘New’ operation to rename it and register it in a database for users. 
 

 

 

 

 

 

 

 

 
 
 

 

 

 

 

 

 

 

 

 

The search function and track-bar slider function enable simultaneous access to 
developer-provided and databases for users, enabling seamless use of the 
databases by the user. 
  

Developer-provided For users

User-use 

database 
Developer- 
provided 

database 

Search 
Search, edit, 

register, delete 

New 
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5.2 Overhead transmission lines 
Select ‘Overhead transmission line’ from the ‘Databases’ menu on the menu bar. 

   
The ‘overhead-transmission-line database editing’ dialog then appears. 
 

 

 

 

 

 

 

 

 

 

Different operations can be performed on the database, depending on whether the 
referenced information is registered in the developer-provided overhead-
transmission-line database or the one for users. See Section 5.1 for the available 
operations. 
 
To edit previously registered data, select the ‘Edit’ radio button. 
 
 
 
To register new data, select the ‘New’ radio button. 

 
 
 

After revising or entering the data, click ‘Register’ to register the information in the 
database. 
 
 
 
To delete registered data, select the ‘Edit’ radio button and click ‘Delete’. 
 
 
 
To finish editing, click ‘Exit’. 
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5.3 Overhead distribution lines 
Select ‘Overhead distribution line’ from the ‘Databases’ menu on the menu bar. 

    
The ‘overhead-distribution-line database editing’ dialog appears. 
 

 

 

 

 

 

 

 

 

See Section 5.2 for details of how to register information. 
 

5.4 Cables 
Select ‘Cable’ from the ‘Databases’ menu on the menu bar. 

   
The ‘cable database editing’ dialog appears. 
 
 

 

 

 

 

 

 

 

 

 

 

 
See Section 5.2 for details of how to register information. 
 

If one or more external 
conductors is set, enter 
external conductor 
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5.5 Line/cable database functions 
This section describes the line/cable database functions. 
 

Search 

This facility is used to search the databases for lines or cables. Enter the text string 
to search for in the ‘Search name’ field, and click ‘Search’. Searches are not case-
sensitive and blanks are ignored. 
 

 

 

The program searches for results containing the entered string. When multiple 
search results are returned, clicking ‘Search’ again displays the next search result. 
 
Example: When ‘AC’ was entered as the search string, ‘AC30’ is displayed. 
 

 

 

 

 

 

 

 

 

 
Clicking ‘Search’ again displays the next search result, ‘AC38’. 

 

 

 

 

 

 

 

 

 

Display switching buttons 
The display switching buttons are used to change the data displayed. 
● ［<<］button 

Displays the first data. 
● ［>>］button 

Displays the last data. 
● ［<］button 
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Displays the data immediately before the current data. 
● ［>］button 

Displays the data immediately after the current data. 
 

Track bar 
Moving the track-bar slider right or left scrolls the displayed data forward or 
backward. A number can also be entered in the input field, before pressing the 
‘Enter’ key to display the data at the indicated location. 
 

 

 

 

 

Import 
This registers user-created line/cable information in CSV format to a database for 
users. Overhead lines and cables each use a different file format. 
 

● Import file layout 

 

 

 

 

 

 

 

 

 

 

 

 

 

● Items with a pound sign (#) in the first column are treated as comments. 

 

Example 

#Name, cross-sectional surface area, outer diameter, electrical resistance, 
dielectric constant 
AC 1,27.09,6.9,2.94,1 
AC 2,125.5,14.5,0.688,1 

 

Export 
This outputs information registered in a database for users to a CSV-format text file. 

  

Slider Numerical input 

Overhead lines Cables

Name Name

Cross-sectional area Number of external conductors
Outer diameter Core wire cross-sectional area
Electrical resistance Core wire outer diameter
Relative magnetic
permeability

Core wire electrical resistance

Core wire relative magnetic permeability
Flag
Main insulator capacitance, or dielectric constant
Inner semiconductor layer thickness
Outer semiconductor layer thickness
Metal sheath outer diameter
Metal sheath thickness
Metal sheath electrical resistivity
Metal sheath relative magnetic permeability
Cable outer diameter, or metal sheath outer insulator
outer diameter
Metal sheath outer insulator dielectric constant
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XFIT (System Identification Program for XTAP) 

Version 1.30 
Instruction manual 

Central Research Institute of Electric Power Industry (CRIEPI) 
October, 2021 

 
 
● Note that starting with Version 1.20, the file format of the frequency-characteristic data 

described in Section 3 of this manual has changed. 

1. Overview 

XFIT is one of the auxiliary programs accompanying the power system transient analysis program 
XTAP (Expandable Transient Analysis Program) developed by CRIEPI. XFIT is a fitting program 
that identifies a linear model given numerical frequency-characteristic data. It can identify models 
for multiple-input/multiple-output systems (multiple phases in the case of electrical circuit elements). 
It can also create an electrical-circuit model that uses the given frequency characteristic as its 
admittance frequency response, and use it in XTAP. This program was previously provided as a 
stand-alone program called SysIP (System Identification Program). 

2. Linear Model fitting 

Multiphase (multiple-input/multiple-output) pole-residue models are linear models fitted to 
reproduce a frequency characteristic provided in the form of numerical data. In other words, the 
numerical data provided follow a model expressed as 

        (1) 

where Y(jω) is the frequency-response matrix provided by the user in the form of numerical data 
(in the case of M phases, this is a matrix of size M × M), Rn is the residue matrix (of size M × M), 
pn is a pole, and ω is the angular frequency. Models were fitted using a least-squares approach. 
See the following references for the detailed procedure. 
 
[1] CRIEPI Research Report T03013: “A sub-network reduction method for the calculation of 

electromagnetic transients in a power system (Part 1)” [in Japanese] (← Can be downloaded 
from the CRIEPI website.) 

[2] T. Noda, “Identification of a multiphase network equivalent for electromagnetic transient 
calculations using partitioned frequency response”, IEEE Trans., Power Delivery, Vol. 20, No. 
2, Part 1, pp. 1134-1142, Apr. 2005 (← Can be downloaded from the IEEE website.) 

[3] T. Noda, “A binary frequency-region partitioning algorithm for the identification of a multiphase 
network equivalent for EMT studies”, IEEE Trans., Power Delivery, Vol. 22, No. 2, pp. 1257-
1258, Apr. 2007 (← Can be downloaded from the IEEE website.) 

[4] J. Martinez (ed.) “Power System Transients: Parameter Determination”, CRC Press (← Link 
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to Amazon listing; the procedure is described in Appendix A of this book.) 

3. Frequency-Characteristic Data Preparation 

(1) The pole-residue models described by Formula (1) are fitted to reproduce a provided numerical 
frequency characteristic. This section describes the method for preparing the frequency 
characteristic data. XFIT assumes the data are stored in files with the following format: 
● The numerical data is separated by spaces or tabs. 
● If the model to be identified has M phases (M inputs and M outputs) (i.e., the Y(jω) term in 

Formula (1) has size M × M), the frequency-characteristic data are stored in M separate files. 
● Each file stores the data for one row of Y(jω). 
● The number of frequencies must be the same in each of the M data files. 
● The data format of the file storing the jth row of Y(jω) is as follows: 

 
f(1)  mag(1,j,1)  phi(1,j,1)  mag(2,j,1)  phi(2,j,1) ･･･ mag(M,j,1)  phi(M,j,1) 

f(2)  mag(1,j,2)  phi(1,j,2)  mag(2,j,2)  phi(2,j,2) ･･･ mag(M,j,2)  phi(M,j,2) 

  :          :             :             :             :               :             : 

f(k)  mag(1,j,k)  phi(1,j,k)  mag(2,j,k)  phi(2,j,k) ･･･ mag(M,j,k)  phi(M,j,k) 

  :          :             :             :             :               :             : 

f(K)  mag(1,j,K)  phi(1,j,K)  mag(2,j,K)  phi(2,j,K) ･･･ mag(M,j,K)  phi(M,j,K) 

 
where f(k) is the kth frequency; 
  mag(i,j,k) is the amplitude of element (i, j) at the kth frequency; 
  phi(i,j,k) is the phase [deg] of element (i, j) at the kth frequency; 
  K is the number of frequencies. 
● Note that this is an updated format created for the current version of XFIT (Version 1.20). 
 

● The first few lines of each file can be used freely as a header. Header lines are automatically 
skipped. 
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4. Five Steps for Model Fitting 

Using the XFIT window (shown below), follow the five steps below to fit the model. 
 

 
 
Step 1 
(Section in window: Number of phases) 
Specify the number of phases M (‘Nph’ on the screen). M corresponds to the size of Y(jω). 
 
Step 2 
(Section in window: Frequency response data files) 
Specify the M files prepared as described in the last section. 
 
Step 3 
(Section in window: Error tolerance in relative quantity) 
Specify the error tolerance as a relative value (%). This value is used for pole fitting. Specify a value 
in the range 0 ≤ EpsR. The default value is 1%. 
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Step 4 
(Section in window: Low level fitting parameters) 
Specify detailed parameter settings if necessary. Note that most of these parameters are set to 
default values considered to be appropriate, and should not normally need alteration. 

● Nmin: Start order for an optimal model-order search. (Range: 1 ≤ Nmin ≤ Nmax; Default: 6) 
● Nmax: Stop order for an optimal model-order search. (Range: Nmin ≤ Nmax; Default: 16) 
● Nitr: Iteration stop count for a rational function fitting process. (Range: 1 ≤ Nitr; Default: 30) 
● Nsvd: Constant used in SVD (singular value decomposition) calculations in the least-squares 

method. If the number of significant digits in a given value is less than this constant, the value 
is removed from the simultaneous equations. (Range: 0 ≤ Nsvd ≤ 16; Default: 2) 

● symmetric: Flag indicating whether the system to be fitted (i.e., the matrix provided) is 
symmetric (checked) or asymmetric (unchecked). (Default: checked) 

● limit poles: If this flag is checked, the poles with an absolute value greater than the maximum 
angular frequency are removed. (Default: unchecked) 

● pole clustering: Flag determining whether or not to consolidate nearby poles into a single pole. 
Poles are consolidated when this setting is checked, and kept separate when unchecked. 
(Default: unchecked) 

● EpsP: When the ‘pole clustering’ setting above is checked, any poles within the radius specified 
by this parameter are consolidated into a single pole. The value is specified as a relative value 
(%). (Default: 5%) 

● outputs: When this flag is checked, intermediate results are output. When not checked, 
intermediate results are not output. (Default: checked) 

 
Step 5 
(Section in window: Start fitting) 
Press ‘Start’ to begin fitting the model. When it is finished, the ‘ResultViewer’ window opens to 
display the results. 
 

5. Displaying and Saving Identification Results 

The ‘ResultViewer’ window shown below opens automatically when model fitting is completed. This 
window can be used to display the following graphs: 

● Plot (i,j) element of Y: shows the fitting of model element (i, j). It compares the frequency 
characteristic of element (i, j) in the data provided to the frequency characteristic of element (i, 
j) in the model. The horizontal axis (frequency) may be either linear or logarithmic. 

● Eigenvalues of Re{Y}: plots the eigenvalues of Re{Y(jω)} versus frequency for the fitted model. 
The horizontal axis (frequency) may be either linear or logarithmic. If the eigenvalues of 
Re{Y(jω)} are positive for all the frequencies, the fitted model is guaranteed to be positive-
definite (i.e., passive). 

 



- 183 - 

 
 
The fit results can be saved in the following formats from the ‘ResultViewer’ window: 

● network equivalent in XTAP format: generates and saves data in a format that can be used 
from a ‘Condensed multiphase circuit model’ (NetEquiv) XTAP part. An admittance element 
with the frequency response fitted by XFIT can be created in an XTAP circuit diagram by 
placing a condensed multiphase circuit model in the circuit diagram, double-clicking on it, and 
using the window that appears to specify the file generated by this item. 

● binary format: outputs the identification results as a binary file. 
● text format: outputs the identification results as a text file. 
● MATLAB format: outputs the identification results as a MATLAB *.mat file, enabling them to be 

loaded into MATLAB using the ‘load’ command. 
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Binary files have the following format: 
1) Number of phases M (integer) 
2) Number of real poles Nr (integer) 
3) Number of complex poles Nc (integer) 
4) Real poles (double; number of values = Nr) 
5) Real parts of complex poles (double; number of values = Nc) 
6) Imaginary parts of complex poles (double; number of values = Nc) 
7) Residue matrix of real poles (double; number of values = M × M × Nr; each matrix row is 

provided first, then Nr matrices) 
8) Real part of residue matrix of complex poles (double; number of values = M × M × Nc; first 

each matrix row, then Nc matrices) 
9) Imaginary part of residue matrix of complex poles (double; number of values = M × M × 

Nc; first each matrix row, then Nc matrices) 
where 
 ‘integer’ is an integer type (32-bit) 
 ‘double’ is a floating-point real number type (64-bit) 
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